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Important Safety Information

WARNING: Never look into the projector lens when the lamp is turned on; the bright light can damage your eyes.
Never let children look into the lens when it is on. Never open any cover on the projector, except the lamp and
filter covers. Dangerous electrical voltages inside the projector can severely injure you. Except as specifically
explained in this User’s Guide, do not attempt to service this product yourself. Refer all servicing to qualified service
personnel.

WARNING: The projector and its accessories come packaged in plastic bags. Keep plastic bags away from small
children to avoid any risk of suffocation.

Caution: When you replace the lamp, never touch the new lamp with your bare hands; the invisible residue left by
the oil on your hands may shorten the lamp life. Use a cloth or glove to handle the new lamp.

Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in
any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior
written permission of Seiko Epson Corporation. The information contained herein is designed only for use with
this Epson product. Epson is not responsible for any use of this information as applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for
damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of
this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to
strictly comply with Seiko Epson Corporation’s operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or
any consumable products other than those designated as Original Epson Products or Epson Approved Products by
Seiko Epson Corporation.

Trademarks

Epson and Instant Off are registered trademarks, and Epson Exceed Your Vision and Duet are trademarks of Seiko
Epson Corporation.

PowerLite and PrivateLine are registered trademarks; SizeWise is a trademark; and Epson Store and Extra Care are
service marks of Epson America, Inc.
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Welcome

T'he PowerLite® 400W is a portable, short-throw projector that
weighs less than 8 pounds (3.6 kg) and offers 1800 ANSI lumens of
brightness. From classrooms to boardrooms, your full-color
presentations and videos will be bright and vibrant even in ordinary
indoor lighting.

Images are displayed at a native resolution of 1280 x 800 pixels
(WXGA) in a wide-screen 16:10 aspect ratio. Epson® 3LCD
technology ensures accurate color and remarkable saturation, even in
well-lit rooms.

The projector’s ground-breaking short-throw lens is ideal for wall
mounting, allowing more space for your class or audience with no
shadow cast by the presenter. It can be placed as close as 21 inches
(54 cm) from a screen, an interactive whiteboard (IWB), or another
projection surface. And its powerful 10 W speaker and crisp 500:1
contrast ratio ensure your presentations are seen and heard at their
best.

You can connect the projector to a wide range of computers, including
IBM®-compatible PCs and laptops, Apple® PowerPC® and Intel®
Core™ Macintosh® computers, PowerBook®computers, and many
iMac® and iBook® series systems. With Epson’s patented SizeWise™
technology, the projector supports computer displays ranging from
VGA through WSXGA+. You can also connect the projector to a
LAN (local area network) so you can monitor the projector from a
remote network computer using the included EMP Monitor software
(Windows® only).

You can use any of the following video sources: HDTV, VCR, DVD
player, gaming console (such as Microsoft® Xbox," Sony®

PlayStation® 3, and Nintendo Wii™), camcorder, or digital camera.
The projector supports NTSC, PAL, and SECAM video formats.
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You can connect up to four devices to the projector at the same time.
With the projector’s Source Search button, you don’t even have to
identify your input source. Just press the button until you see the
image you want on the screen.

To prevent unauthorized use of the projector, you can assign a
password, create a user logo which is displayed at startup to identify
the projector, and disable the projector’s buttons through a full or
partial Control Panel Lock feature. For more information about
security features, see page 66.

Getting the Most from Your Projector

Depending on your presentation, you can take advantage of any or all
of these options:

m Connecting to a laptop or other computer
If you want to connect the projector to a laptop or desktop
computer, see page 20. For additional presentation control, you
can connect an external monitor to view the presentation on your
computer simultaneously.

m Connecting to video sources
You can connect a DVD player, VCR, HDTYV, camcorder, digital
camera, and other video sources to your projector. See page 26 for
instructions.

m Using the remote control
The remote control lets you switch from computer to video
sources, zoom in on part of your image, freeze or mute the
presentation, and adjust many other projector features. For
details, see Chapter 3.

m  Enhancing sound in your presentation
By connecting your projector to external speakers, you can
enhance the audio impact of your presentations. (The internal
10 W speaker provides powerful sound, but is disabled when you
connect external speakers.) See page 25 for details.



Using Your Documentation

In addition to this manual, your documentation includes a Quick
Setup sheet, warranty brochures, and an Epson PrivateLine® Support
card.

The Quick Setup sheet gives instructions to quickly set up your
projector and connect it to a computer or video device.

This book contains all the information you need to set up and use
your projector. Please follow these guidelines as you read through it:

m  Warnings must be followed carefully to avoid bodily injury.
B Cautions must be observed to avoid damage to your equipment.

m  Notes contain important information about your projector.

Getting More Information

Need tips on giving presentations? How about quick steps for setting
up your projector? Here’s where you can look for help:

B www.presentersonline.com
Includes a library of articles covering presentation tips, tricks, and
technology. The site provides templates, clip art, and sound clips,
as well as Presenters Services to use on the road. Even more
resources and services are available if you register to join the
Presenters Club—and it’s free.

m Built-in help system
Press the Help button on the remote control or projector to get
quick solutions for common problems. See page 82 for details.

E epson.com/support
Download FAQs (frequently asked questions) and e-mail your
questions to Epson support.

If you still need help after checking this User’s Guide and the sources
listed above, you can use the Epson PrivateLine Support service to get
help fast. Call (800) 637-7661 and enter the PIN on your PrivateLine
Support card. See page 91 for more information.

Welcome
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Registration and Warranty

Your projector comes with a basic carry-in warranty. For details, see
the warranty brochure that came with your projector.

In addition, Epson offers Extra Care’™ Road Service at no additional
charge. In the unlikely event of an equipment failure, you won’t have
to wait for your unit to be repaired. Instead, Epson will ship you a
replacement unit anywhere in the United States or Canada, usually
within one business day. See the Extra Care Road Service brochure for
details.

To register, complete the registration form that came with your
projector and mail it to Epson. Or register your product online using
your projector CD, or at:

http://www.epson.com/webreg

Registering also lets you receive special updates on new accessories,
products, and services.

Unpacking the Projector

After unpacking the projector, make sure you have all these items:

Projectorand %
lens cover >

o,
052620,
2,
252

g S Remote control
w and batteries

Password Protected
VGA computer Power cord Projector sticker
cable CD-ROMs

Save the protective pad attached to the lens cover and all other
packaging in case you need to ship the projector. Always use the
original packaging (or equivalent) when you send the projector to
another location. See page 80 for transportation instructions.
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Projector Parts
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Control Panel

Up/down arrows and

Turns projector Opens menu system keystone correction

on and off

- | Cancel/exit
Menu W
Source
Search Help
Opens help

' wme(j TeIe@ system
e Lmoum | o
status 4 ©Temp
Searchls for Left/right arrows Automatically
source image and adjusts computer

Wide/Tele buttons  images

Additional Components

Depending on how you plan to use the projector, you may need
additional components:

To receive an S-Video signal, you need an S-Video cable. One is
usually provided with your video device or you can purchase it
from Epson. See page 13.

To receive a component video signal from a VCR or other video
device, you need a D-sub, 15-pin, component-to-VGA video
cable, which is available for purchase from Epson. See page 13.

Some older PowerBooks and Macintosh desktop models may
need a Macintosh video adapter; see your computer dealer. Older
iMac systems may need a special VGA adapter, and newer iMac,
MacBook, and PowerBook systems may need a mini
DVI-to-VGA adapter; see your computer dealer.

To receive an audio signal, you need a commercially available
audio cable; see your computer or electronics dealer.



Optional Accessories

To enhance your use of the projector, Epson provides the following
optional accessories:

Product Product number
Replacement lamp V13H010L42
Air filter set (includes 2 filters) V13H134A13
Replacement remote control 1456641
Presentation remote control V12H007T0B
Component-to-VGA video cable ELPKC19
S-Video cable ELPSVO1
Distribution amplifier ELPDAO1
Short-throw Projector Wall Mount ELPMSTPW
Projector Wall Mount Security Module ELPMSECM
Interactive Whiteboard Retrofit Installation Module | ELPMIWBM
50-inch portable screen (4:3 aspect ratio) ELPSCO6
60-inch portable pop-up screen (4:3 aspect ratio) ELPSCO7
80-inch portable pop-up screen (4:3 aspect ratio) ELPSCO08
83.6-inch hanging pull-down screen ELPSCO09
(4:3 aspect ratio)
Duet™ Ultra Portable Projector screen ELPSC80
(4:3 and 16:9 aspect ratio)
ELPDCO5 high resolution document imager V12H162020
Kensington® security lock ELPSLO1
Ceiling mount (gyro lock with suspension adapter) ELPMBUNI
False ceiling plate ELPMBFCP
Suspension adapter ELPMBAPL
Security bracket/cabling for gyro lock mounts ELPMBSEC
Adjustable ceiling channel ELPMBACC

You can purchase screens, carrying cases, or other accessories from an
Epson authorized reseller. To find the nearest reseller, call
800-GO-EPSON (800-463-7766). Or you can purchase online at

www.epsonstore.com (U.S. sales) or www.epson.ca (Canadian sales).

note

To purchase a replacement
remote control, call

(562) 276-4394 (U.S.) or
(905) 709-3839 (for dealer
referral in Canada).
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Setting Up the Projector

This chapter tells you how to set up the projector and connect it to a
computer or video source. You can connect up to four devices
simultaneously: four video sources, or two computer and two video
sources.

You'll find instructions for the following in this chapter:
m  Positioning the projector
m  Connecting to a computer

m  Connecting to video sources

15



Positioning the Projector

Before connecting the projector, you need to decide where to place it.
If the projector isn’t already installed in the room you’re using, you

note can place it on a table in front of the screen. This lets you stand in the
You can download the front of the room, face the audience, and control the projector.
Projection Distance

Caleulator program from Ideally, you should place the projector between 26 to 48 inches (66 to
the Drivers & Downloads 122 cm) from the screen. Use the illustrations and tables below to
section of Epson’s website: help you determine approximately how far to place it based on the

WWW.pson.com/support  g.een size you’re using and the aspect ratio of the image. Image size

can vary depending on how you adjust the zoom and other settings.

% 777777777777777777777777777777777777 Center of
lens

=)
1@

' KX
,,,,,,,,,,,,,,,,,,,,,,,,,,,,,, LB)_lC:enter of ®
A O ens Ko
B
I

A

A
A
oY

16:10 aspect ratio

Projection distance (A) Offset (B)
Screen size Wide to Tele Wide to Tele
50 inches 21 to 29 inches 4 to 10 inches
(127 cm) (54 to 73 cm) (10 to 25 cm)
60 inches 26 to 35 inches 4.81t0 12 inches
(152 cm) (65 to 89 cm) (12 to 30 cm)
70 inches 30 to 41 inches 5.6 to 14 inches
(178 cm) (76 to 104 cm) (14 to 36 cm)
80 inches 34 to 47 inches 6.4 to 16 inches
(203 cm) (88to 119 cm) (16 to 41 cm)
90 inches 39 inches 7.2 inches
(229 cm) (99 cm) (18 cm)
100 inches 43 inches 7.9 inches
(254 cm) (110 cm) (20 cm)
110 inches 48 inches 8.7 inches
(279 cm) (122 cm) (22 cm)
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4:3 Aspect Ratio

Screen size Projection distance (A) Offset (B)
(diagonal) Wide to Tele Wide to Tele
44 inches 21 to 29 inches 4 to0 13.1 inches
(112 cm) (54 to 73 cm) (10 to 33 cm)
50 inches 24 to 33 inches 4.5 10 14.7 inches
(127 cm) (61 to 83 cm) (11 to 37 cm)
60 inches 29 to 40 inches 5.4 to 17.6 inches
(152 cm) (73 to 100 cm) (14 to 45 cm)
70 inches 34 to 46 inches 6.3 t0 20.6 inches
(178 cm) (86 to 118 cm) (16 to 52 cm)
80 inches 39 inches 7.2 inches
(203 cm) (99 cm) (18 cm)
90 inches 44 inches 8.1 inches
(229 cm) (112 cm) (21 cm)
97 inches 48 inches 8.7 inches
(246 cm) (122 cm) (22 cm)
16:9 Aspect Ratio
Projection distance (A) Offset (B)
Screen size Wide to Tele Wide to Tele
49 inches 21 to 29 inches 5.3 to 12 inches
(124 cm) (54 to 73 cm) (13to 30 cm)
60 inches 26 to 36 inches 6.5 to 14.7 inches
(152 cm) (67 to 91 cm) (17 to 38 cm)
70 inches 3110 42 inches 7.6to 17.2 inches
(178 cm) (78 to 107 cm) (19 to 44 cm)
80 inches 35 inches 8.7 inches
(203 cm) (90 cm) (22 cm)
90 inches 40 inches 9.8 inches
(229 cm) (102 cm) (25 cm)
100 inches 45 inches 10.9 inches
(254 cm) (113 cm) (28 cm)
107 inches 48 inches 11.7 inches
(272 cm) (122 cm) (30 cm)

Setting Up the Projector
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Also keep these considerations in mind:

m Ifyou're projecting from a table or other flat surface, make sure
the surface is sturdy and level.

Bl

M Make sure there is plenty of space for ventilation around and
under the projector. Do not set the projector next to loose papers
that could block the vents on the sides of the projector.

m  Make sure the projector is within 6 feet (2 m) of a grounded
electrical outlet or extension cord.

m  Place the projector in front of the center of the screen, facing it
squarely. If the projector isn’t positioned this way, the image will

be “keystone” shaped (|| or [_]) instead of rectangular.

If you're projecting from a table or other flat surface, you may need to
tilt the projector up by extending the front adjustable foot, as
described on page 41. This causes the image to lose its rectangular
shape. You can adjust the shape using the buttons on the projector
(see page 42), or using the projector’s menu system (see page 53).

Whiteboard Installation

You can project onto a whiteboard (or IWB, interactive whiteboard)
by mounting the projector to the wall or directly onto a compatibly
equipped whiteboard.

18  Setting Up the Projector



To mount the projector on the wall or attach it to a whiteboard, you’ll
need an optional short-throw wall mounting system. (See page 13 for
ordering information.) You'll also need to select Front/Ceiling for the
Projection option in the Extended menu. See page 62 for details.

Other Installations

You can also project from behind the screen or from the ceiling, with
the projector mounted upside-down:

Rear projection (using a Front/ceiling projection Rear/ceiling projection (using
translucent screen) a translucent screen)
-
—_— —

—

N — =

|
N
i

>

To project from the ceiling, you’ll need the optional ceiling mount.
(See page 13 for ordering information.) You'll also need to select
Front/Ceiling or Rear/Ceiling for the Projection option in the
Extended menu. To project from the rear, select Rear. See page 62 for
details.

Setting Up the Projector
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Connecting to a Computer

You can connect the projector to any computer that has a standard

;Ote/m an iBook with VGA or BNC monitor port, including PC notebook and laptop
ou ve an iDoor wi

anyRCA video-out port computers, Macintosh PowerBooks and iBooks, and hand-held
Jollow the instructions for devices.

mn;:ctzz‘gto a video device Follow the instructions in this section to:

on gf .

m  Connect the projector to your computer with the VGA cable
included with the projector.

m  Connect the projector to your computer with a commercially

available VGA-5BNC cable.

After connecting the projector to your computer, you may also
want to:

m  Connect a monitor to the projector so you can view your
presentation close-up as well as on-screen (not necessary if you're

using a laptop); see page 23.

m  Connect the projector to your computer with a commercially
available audio cable to play computer audio; see page 24.

Connecting with the VGA Cable

Follow these instructions to connect to your computer with the VGA
cable that came with your projector. Before you start, make sure your
computer and the projector are turned off.

1. If you are connecting the projector to a desktop computer,
disconnect the monitor cable from your computer.

2. Locate the VGA computer cable that came
with the projector.

VGA computer cable
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Connect one end of the cable to the projector’s Computer1 or
Computer2 port.

Computer1 and Computer2 ports

L-Audio-R Computer2 Computer1

Video

0000000
0000000
0000000

[e]
[e]
[e]
o
o
o
o
o
o
o
o
o
o
o
o
o
[e]
[e]
o
o

3. Connect the other end of the cable to your computer’s video-out
or monitor port.

If you’re using a PowerBook or iBook and you can’t connect the
cable, you may need to use an optional Macintosh video adapter;
see your computer dealer.

4. If you connected the computer to the Computer1 port and you
want to view the display simultaneously on your computer
monitor and the projector screen, see “Connecting an External
Monitor” on page 23.

5. To play audio from your computer through the projector speaker,
see “Playing Sound Through the Projector” on page 24.

6. Tighten the screws on the connectors.

If you don’t need to make any other connections, you can plug in
y y y plug
your projector and turn it on. See page 36 for instructions.

If more than one device is connected to the projector, select the
correct source after projection starts by pressing the Source Search
button on the projector or remote control. See page 38.

Setting Up the Projector
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Connecting with a VGA-5BNC Cable

If your computer provides video output through BNC connectors,
follow these instructions to connect the projector to your computer
with an optional VGA-5BNC cable. Before you start, make sure your
computer and the projector are turned off.

VGA-5BNC cable

1. Disconnect the monitor cable from your computer.

2. Connect the cable’s VGA connector to the projector’s
Computer1 or Computer2 port.

Computer1 and Computer2 ports

L-Audio-R Computer2 Computer1

Video

3. Connect the BNC connectors to your computer’s BNC ports.

4. If you want to view the display simultaneously on your computer
monitor and the projector screen, see “Connecting an External
Monitor” on page 23.

5. To play audio from your computer through the projector speaker,
see “Playing Sound Through the Projector” on page 24.

6. Tighten the screws on the VGA connector.

If you don’t need to make any other connections, you can plug in
y y y plug
your projector and turn it on. See page 36 for instructions.

If more than one device is connected to the projector, select the
correct source after projection starts by pressing the Source Search
button on the projector or remote control. See page 38.
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Connecting an External Monitor

If you want to see your presentation close-up as well as on the
projection screen, you can connect an external monitor to the
projector. This lets you view images on your computer monitor while
the projector is in standby mode (plugged in but not turned on) and
check your presentation or switch between picture sources even if
you’ve pressed the A/V Mute button on the remote control to turn off
projection on the screen. (Simultaneous display is possible only when
the computer is connected to the projector’s Computer1 port.)

Make sure the projector and computer are off. Then connect the
monitor’s cable to the projector’s Monitor Out port, as shown:

If you don’t need to make any other connections, you can plug in
y y y plug
your projector and turn it on. See page 36 for instructions.

note

Some LCD monitors may
not be able to display the
image correctly. If you have
trouble displaying the
image, connect a multiscan
monitor. If you re projecting
computer images, make sure
the computer’s refresh rate is
set to 60 Hz or greater. See
your computer and/or
monitor documentation for
Instructions.

Setting Up the Projector 23



Playing Sound Through the Projector

You can connect a commercially available 3.5 mm stereo mini-jack
audio cable to take advantage of the projector’s built-in speaker. You
can obtain the audio cable from a computer or electronics dealer.

3.5 mm stereo
mini-jack audio cable 1. Connect one end of the 3.5 mm stereo mini-jack audio cable to

the corresponding Audio1 or Audio2 jack on the projector.

S-Video Video L-Audio-R Computer2 Computer1

00000000000 00
00000000000 00 f
00000000000 0o Audiol
000000000000 00

0000000000000 00 N and
000000000000000 00 .
00000000000000000000 Audio?

000000000000 0O0O000000
000000000000 00O000000 H
J jacks

00000000000 OOOOOO0O0O
KOOOOOOOOOOOOOOOOOOOO

2. Connect the other end of the audio cable to your laptop’s
(') headphone jack or ®) audio-out jack, or your desktop’s
speaker or audio-out port.

If you don’t need to make any other connections, you can plug in
your projector and turn it on. See page 36 for instructions.
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Connecting External Speakers

You can output sound to external speakers with built-in amplifiers.
When you play sound through external speakers, the projector’s
built-in speaker is disabled.

1. Locate the appropriate cable to connect your speakers.

Depending on your speakers, you may be able to use a
commercially available audio cable with a stereo mini-jack
connector on one end and pin jacks on the other end. For some
speakers, you may have to purchase a special cable or use an
adapter.

2. Connect the stereo mini-jack end of the audio cable to the Audio
Out port on the projector.

3. Connect the other end of the cable to your speakers.

Setting Up the Projector 25



note

The projector does not
support TV antenna cable
F connectors.

Connecting to Video Sources

You can connect a DVD player, VCR, camcorder, digital camera,
gaming console, or any other compatible video source to your
projector. You can connect up to four video devices at one time.

The projector supports HDTV, SDTV, NTSC, PAL, and SECAM,
and automatically detects the video format. It can receive composite
video, S-Video, RGB video, and component video. The type of cable
you need depends on the video source:

m  For composite video, use a commercially available RCA A/V
cable. See page 27.

m  For S-Video, use the S-Video cable supplied with your video
device or order one from Epson. See page 28.

m  For RGB video, use the VGA computer cable included with the
projector. See page 29.

m  For component video, you’ll need the optional Epson
component-to-VGA video cable. See page 30.

After connecting your video device to the projector, you may want to
connect an audio cable to play sound from your video equipment
through the projector’s built-in speaker or external speakers. See
page 31 for instructions.
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Connecting a Composite Video Source

If you’re connecting a composite video device, use a commercially
available RCA A/V cable. Before starting, make sure the projector and
your DVD player or other video source are turned off.

1. Connect the yellow RCA plug on one end of the cable to the
projector’s yellow Video port.

Video port

L-Audio-R Computer2 Computer1

Video

2. Connect the yellow plug on the other end of the cable to the

video-out port on your video source.

3. To play sound through the projector, follow the instructions
beginning on page 31.

If you don’t need to make any other connections, you can plug in

your projector and turn it on. See page 36 for instructions.

If more than one device is connected to the projector, select the
correct source after projection starts by pressing the Source Search
button on the projector or remote control. See page 38.
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Connecting an S-Video Source

If your video source has an S-Video jack, you can use it to project a
higher quality video image. You’ll need an S-Video cable, which is
usually provided with your video source, or you can purchase one
from Epson (part number ELPSV01). See page 13 for ordering

information.

Before starting, make sure the projector and your DVD player or
other video source are turned off.

1. Insert one end of the S-Video cable into the projector’s S-Video
port and the other end into the S-Video output port of your video

source.

S-Video port

S-Video Video L-Audio-R Computer2 Computer1

Audio2

2. To play sound through the projector, follow the instructions
beginning on page 31.

If you don’t need to make any other connections, you can plug in
your projector and turn it on. See page 36 for instructions.

If more than one device is connected to the projector, select the
correct source after projection starts by pressing the Source Search
button on the projector or remote control. See page 38.
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Connecting an RGB Video Source

Follow these instructions to connect the projector to a video player or
satellite receiver that has an RGB video output port using the VGA
computer cable that came with the projector.

Before starting, make sure the projector and your DVD player or
other video source are turned off.

1. Connect one end of the VGA computer cable to the Computer1
or Computer2 port on the projector.

Computer1 and Computer2 ports

L-Audio-R Computer2 Computer1

Audio2 Audiol .

Video
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2. Connect the other end to the video port on your player.

3. To play sound through the projector, follow the instructions
beginning on page 31.

If you don’t need to make any other connections, you can plug in

your projector and turn it on. See page 36 for instructions.

If more than one device is connected to the projector, select
Computer 1 or Computer 2 as the source after projection starts by
pressing the Source Search button on the projector or remote
control. See page 38.

Setting Up the Projector
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Connecting a Component Video Source

—=31  If your video source has component video connectors, you can use
—=83  them to project a higher quality video image. You’ll need a
=7 component-to-VGA video cable, which can be purchased from Epson

Component-to-VGA (part number ELPKC19). See page 13 for ordering information.
video cable

Before starting, make sure the projector and your DVD player or
other video device are turned off.

1. Connect the 15-pin VGA connector end of the
component-to-VGA video cable to the projector’s Computer1 or
Computer2 port.

Computer1 and Computer2 ports

Video  L-Audio-R Computer2 Computer1

2. Insert the three component ends of the component-to-VGA video

cable into the color-coded video output ports on your video
source, usually labelled Y, Pb, Pror Y, Cb, Cr.

3. To play sound through the projector, follow the instructions
beginning on page 31.
If you don’t need to make any other connections, you can plug in

your projector and turn it on. See page 36 for instructions.

If more than one device is connected to your projector, select
Computer1 or Computer2 as the source by pressing the Source
Search button on the projector or the remote control. See page 38.
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Playing Sound Through the Projector

The projector has a built-in speaker with a maximum output of 10 W.

You can play sound from your video equipment through the

projector’s speaker if your video device has an audio output port.

For RCA-Type Audio Output Ports

Most video devices have an RCA-type audio output port. In this case,
use a commercially available RCA-type audio cable to connect the

projector to your video source:

1.

Connect one end of the RCA audio cable to the L-Audio-R jacks
on the projector.

L-Audio-R jacks (for Video and S-Video ports)

L-Audic-R Computer2 Computer1

S-Video Video
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2. Connect the red and white plugs on the other end of the RCA

audio cable to the corresponding color-coded audio output port
on your video source.

If you don’t need to make any other connections, you can plug in

your projector and turn it on. See page 36 for instructions.
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For Stereo Mini-Jack Audio Output Ports

Some video devices, especially camcorders, may have a stereo
mini-jack audio output port. To connect to the L-Audio-R input
jacks when using the S-Video or Video port, use a commercially
available stereo mini-jack audio adapter cable (3.5-mm stereo
miniplug to two male RCA plugs) to connect to the projector.

1. Connect one end of the audio adapter cable to the L-Audio-R
jacks on the projector.

L-Audio-R jacks

S-Video Video L-Audic-R Computer2 Computer1

2. Connect the other end of the audio adapter cable to your video
device’s audio output port.

If you don’t need to make any other connections, you can plug in
your projector and turn it on. See page 36 for instructions.
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Connecting External Speakers

You can output sound to external speakers with built-in amplifiers.
When you play sound through external speakers, the projector’s
built-in speaker is disabled.

1. First connect your video and audio input cables as necessary.
2. Locate the appropriate cable to connect your external speakers.

Depending on your speakers, you may be able to use a
commercially available audio cable with a stereo mini-jack
connector on one end and pin jacks on the other end. For some
speakers, you may have to purchase a special cable or use an
adapter.

3. Connect the stereo mini-jack end of the audio cable to the
Audio Out port on the projector.
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4. Connect the other end of the cable to your speakers.

The projector’s internal speaker is disabled while sound is output to
external speakers, but you can use the remote control to adjust the

volume.

Setting Up the Projector
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Projecting

Once you’ve set up the projector, you’re ready to turn it on, adjust

the image, and give your presentation.

Although you can operate the projector without it, the remote control

lets you use additional features. See Chapter 3 for instructions on

using the remote.

This chapter covers the following:

Turning on the projector and other equipment
Adjusting the image
Adjusting the volume

Shutting down the projector
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Turning On Your Equipment

Make sure your projector and other equipment are set up and
connected correctly, as described in Chapter 1. Then turn on your
projector, as described below.

If you turn on your connected computer or video equipment before
starting the projector, the projector automatically detects and displays
the image source. If you turn on the projector first, or have multiple
pieces of connected equipment, you may have to select the image
source manually. See page 38.

Turning On the Projector
Follow these steps to plug in and turn on the projector:

1. Remove the lens cover.

2. Connect one end of the power cord to the projector’s power inlet,
then connect the other end to an electrical outlet. The © Power
light on top of the projector turns orange, indicating that the
projector is receiving power but is not yet turned on.
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3. Turn on your computer or video source if you have not already.

4. Press the O Power button on the projector or on the remote

control to turn it on.

Power button

EPSON

Source
Power Search  Help

Menu A Esc

Vol—_ Enter/Auto Vol+
>

The projector beeps and the O Power light flashes green as the
projector warms up. The projector lamp comes on in about
5 seconds and the O Power light stays green.

m Ifyou're using a computer, you should see your computer
display projected after a moment or two. If not, you need to
select the image source. See page 38.

(With Windows, if you see a message saying that it has found
a plug-and-play monitor, click Cancel.)

m Ifyou're projecting a video, you may need to press the
Source Search button on the projector or remote control to
switch to your video source. Then press the Play button on
your DVD player or other device.

m Ifyou are prompted to enter a password, see page 70.

To focus and adjust the image, see page 40. If a projected image fails
to appear, see “What To Do If You See a Blank Screen” on page 38.

When you’re done, shut down the projector as described on page 44.

note

If you are using the remote
control for the first time, be
sure to insert the batteries as
described on the Quick
Setup poster.

warning

Never look into the lens when
the lamp is on. This can
damage your eyes, and is
especially dangerous for
children.
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note

The name of the selected
image source appears briefly
in the upper right corner of
the screen.
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Selecting the Image Source

Selecting the image source lets you switch between images input from
different pieces of equipment connected to the projector (such as a
computer and DVD player). If you don’t see the image you want,
press the Source Search button on the remote control or projector
until the correct device image is projected. If a projected image fails to
appear, see the next section for help.

Once you see your image, turn to page 40 for instructions on focusing
and making other image adjustments.

What To Do If You See a Blank Screen

If you see a blank screen or a blue screen with the message No Signal
after turning on your computer or video source, try the following:

B Make sure the cables are connected correctly, as described in

Chapter 1.

B Make sure the O Power light is green and not flashing and the
lens cover is removed.

B Make sure you've selected the correct image source; see the
previous section. Allow a few seconds for the projector to sync up
after pressing the button.

m  Check the Signal menu to make sure the correct input source is
selected. See page 58.

If you're using a PC laptop:

m  Hold down the Fn key and press the function key that lets you
display on an external monitor. It may have an icon such as 2/0)
or it may be labelled CRT/LCD. Allow a few seconds for the
projector to sync up after pressing it. Check your laptop’s manual
or online help for details.

On most systems, the 2/) or CRT/LCD key lets you toggle
between the LCD screen and the projector, or display on both at
the same time.



m Ifyou're projecting from a laptop, and you don’t see the same
image on the projection screen and computer screen, check your
monitor settings to make sure both the LCD screen and the
external monitor port are enabled.

From the Control Panel, open the Display utility. Click the
Settings tab, then click Advanced. The method for adjusting
the settings varies by brand; you may need to click a Monitor tab,
then make sure the external Monitor port is set as your primary
display and/or enabled. See your computer’s documentation or
online help for details.

If you're using a Macintosh laptop with OS X:

You may need to set up your system to display on the projector screen
as well as the LCD screen. Follow these steps:

1. From the Apple menu, select System Preferences, then click
Display or Displays.

2. Select VGA Display or Color LCD, click Arrange or
Arrangement, and make sure Mirror Displays is checked.

20 VGA Display =)
« mAa@ @
cli Show Al Displays Sound Network Startup Disk
lick here Display [ Arrange | Color

To rearrange the displays, drag them to the desired position
To relocate the menu bar, drag it to a different display.

Select Mirror
Displays

t——— Mirror Displays
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Adjusting the Image
Once you see your image, you’ll need to make certain adjustments:
m  To focus or zoom your image, see below.

m  If the image is too high or too low, you can reposition it.
See page 41.

m  If the image isn’t square, see page 42.
B To adjust image brightness, see page 42.
m Ifa computer image displays incorrectly, see page 43.

You can make many other adjustments to the image—such as
changing the brightness, contrast, and aspect ratio—using the
projector’s menu system. See Chapter 4 for more information.

Focusing and Zooming Your Image

Rotate the focus ring to sharpen the image.

gl

Focus
ring

—

)

Press the Wide button on the projector to enlarge the image, or the
Tele button to reduce it.

~
5 @ O @
o
8-©)Lamp Enter—”
§ ©Temp @
<

Wide Tele
button button
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You can also change the image size by moving the projector closer to
or farther away from the screen. You can use the E-Zoom buttons on
the remote control to zoom in on a portion of the image. See page 49
for instructions.

Adjusting the Height of Your Image

If you’re projecting from a table or other flat surface and the image is
too high or low, you can correct it by adjusting the projector’s front
and/or rear feet.

1. To adjust the front foot, stand behind the projector. Press up on
the blue foot release lever and lift the front of the projector to
extend the front adjustable foot.

2. Once the image is positioned where you want, release the lever to
lock the foot in position.

3. To adjust the rear feet, rotate the feet to extend or retract them to

the desired height.

S

s

>

If the projected image isn’t rectangular, follow the instructions in the
next section.
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Adjusting the Image Shape

If the projector is tilted up or down, the images that are displayed will
be distorted. To correct the distortion or “keystone” shape, do one or
more of the following:

m  If your image looks like D or E, you’ve placed the projector
off to one side of the screen, at an angle. Move it directly in front
of the center of the screen, facing the screen squarely.

m  If your image looks like D or D, you need to adjust the
keystone correction value. Press the 7\ or \_/ buttons on the
projector to correct the shape of the image. After correction, your
image will be slightly smaller.

Ll

P

ay
Menu @ Esc |
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You can also make keystone adjustments using the projector’s Settings
menu. See page 60.

Adjusting the Brightness

The brightness of an image depends on the source you are projecting
and the amount of light in the room. If the image is too bright or not
bright enough, here are two ways you can adjust it:

m  Change the Brightness setting in the Image menu. See page 57.

m  Select Low or High for the Brightness Control option in the
Settings menu. (See page 61.) Low brightness mode extends the
life of the lamp and decreases the fan noise.



Correcting Computer Images

If you've connected a computer and the image doesn’t look right, or it
doesn’t fit properly on the screen, press the Enter button on the
projector or the Enter/Auto button on the remote control. This
automatically resets the projector’s tracking, sync, resolution, and
position settings. You must be projecting a computer image for this
button to have any effect. Additionally, if the Auto Setup option in
the Signal menu is set to Off, the Auto function will not work. See

page 59.

Adjusting the Volume

You can use the Vol- and Vol+ buttons on the remote control to

increase or decrease the volume for the projector’s built-in speaker. note
A volume gauge appears on the screen while the volume is being You can also adjust the
adjusted. volume using the projector’s
Settings menu. See page 60
- Jfor details.
" EpsoN |
Power (g% You must adjust t/a'e volume
wem 2 Esc separately for each input
source.

Vol Enter/Auto Vol+
< >

ColorMode Aspect

J- Freeze [~
%D Volume control

A/VMute
buttons

——
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note

When the projector has nor
received any input signals
Jfor 30 minutes, it
automatically turns off the
projector lamp and enters
“sleep mode.” This conserves
electricity, cools the
projector, and extends the
life of the lamp. If you are
done using the projector,
unplug the power cord. If
you want to start projecting
again, press the O Power
button. You can turn sleep
mode on or off through the
Extended menu. See

page 63.

Turn off this product when
not in use to prolong the life
of the projector.

caution

To avoid damaging the
projector or lamp,
never unplug the power
cord when the

O Power light is green

or flashing orange.
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Shutting Down the Projector

When you’ve finished using the projector, follow the recommended

procedure to shut it down.

1.

If you’re using a computer, shut it down first; otherwise you may
not be able to see your computer’s display to shut it down

properly.
To turn off the projector, press the O Power button on the
projector or remote control.

You see this confirmation message:

(If you don’t want to turn it off, PO

Yes: Press @ button
Ho - Press any other button

press any other button or wait a
few seconds until it disappears.)

Press the © Power button again. The projector beeps twice, the
lamp is turned off, and the O Power light turns orange. (To turn
the projector on again, press the O Power button.)

With Epson’s exclusive Instant Off® technology there’s no
cool-down period, so you can pack up and go immediately after
turning off the projector.

Press up on the blue foot release lever and lower the projector to
retract the front adjustable foot.

Attach the lens cover.

Unplug the power cord.

Turn off and disconnect any equipment plugged into the
projector.

If you won’t be using the projector for awhile, attach the lens
cover’s protective pad. Then store it in a protective case.



Using the Remote Control

The remote control lets you access your projector’s features from
anywhere in the room—up to 20 feet (6 m) away. For example, you
can turn the projector on and off, freeze the presentation, zoom in on
a portion of your image, and access the menu system. (The projector
menus let you adjust many projector settings; see Chapter 4.)

When using the remote control, stand within 20 feet (6 m) of the
projector. Point the remote control either at the front or back of the
projector or at the screen (the projector’s front sensor can detect
signals bounced off the screen). Press the button for the function you
want to use.

This chapter covers the following information:
m  Controlling the picture and sound

m  Replacing the remote control batteries
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Controlling the Picture and Sound

You can use the remote control to select your source, adjust the colors,
temporarily turn off the picture and sound, freeze the action, or zoom
in on the picture. Make sure you have set up your projector and
connected any equipment as described in Chapter 1.

Switching Between Picture Sources

If you’ve connected your projector to more than one computer and/or
video source, you can use the Source Search button on the projector
or remote control to switch between the different sources.

EPSON
Power g  Help
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Menu A Esc

Vol— Enter/Auto Vol+

ColorMode Aspect

v
+ Freeze
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Menu Esc
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e) Search @ @ @ Help

w3 @ D=0
B8-©)Lamp Enter”
§ ©Temp @

X

Source Search
button

After you select a source, the screen goes dark for a moment before the
image appears. The name of the selected source (such as Computer1
or S-Video) appears briefly on the screen.
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Adjusting the Color Mode

You may want to adjust the color mode to select a different setting

that is appropriate for the image you’re projecting and the

environment in which you’re projecting it. Press the Color Mode

button on the remote control.

If you’re projecting computer or RGB video images, the default color

mode is Presentation, which is appropriate for full-color

presentations in bright rooms.

The following table lists the color modes available.

Color mode

Description

Game

Brightest mode, best for playing video games in a
bright room.

Presentation

Use when you're projecting a full-color presentation in
a bright room.

Text Use when you're projecting a black and white
presentation in a bright room.

Theatre Use when projecting movies in a dark room.

Photo Best for projecting still images with vivid color in a
bright room (computer input only).

sRGB Use when projecting computer images conforming to
the sRGB color standard.

Blackboard Choose this fixed color mode when you need to

project against a green blackboard.

You can also use the projector menu system to change the color mode

in the Image menu (see page 57).

Color
Mode
button
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Turning Off the Picture and Sound

Press the A/V Mute button on the remote control to turn off the
image and sound and darken your screen. This is useful if you want to
temporarily re-direct your audience’s attention without the distraction
of a bright screen.

To turn off the picture and sound, press the A/V Mute button. The

screen goes dark.
To turn the image and sound back on, press the button again.

You can create an image, such as a company logo or a picture, to
display on the screen whenever you press the A/V Mute button. See
page 67 for more information.

Stopping Action

Press the Freeze button to stop the action in your video or computer
image and keep the current image on the screen. The sound will
continue, however. Also, because the source continues to transmit
signals, you won’t resume the action from the point you paused it.

To restart the action, press the Freeze button again.
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Zooming Your Image
Follow these steps to zoom in on a portion of the image:
1. Press the E-Zoom + button on the remote control.
You see a crosshair indicating the center of the zoom-in area.

2. Use the four “arrow” buttons on the remote control to position
the crosshair in the area you want to enlarge.

3. Continue pressing the E-Zoom + button to enlarge the selected
area up to 4 times.

4. While the image is enlarged, you can:
B Use the arrow buttons to pan about.
B Press the E-Zoom - button to zoom out.

5. When you’re done, press the ESC button to return to the original
size.

Changing the Image’s Aspect Ratio

You can use the Aspect button on the remote control to change the
aspect (width to height) ratio, depending on the input signal.

m  Auto (video images only)
Automatically sets the aspect ratio according to the input signal.
4:3 ratio images display at 4:3, squeeze-recorded signals display at
16:9, and letterbox signals display at Zoom ratio (described
below).

m  Normal
Displays images using the full projection area and maintains the
aspect ratio of the image. 4:3 ratio images project with black
bands on the sides, 16:9 images project with black bands on the
top and bottom, and 16:10 images use the entire projection area.

m 169
Converts the aspect ratio of the image to 16:9. 4:3 ratio images
are elongated horizontally to fit.
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Zoom

Displays images using the full width of the projection area and
maintains the aspect ratio of the image. 4:3 ratio images are cut
off on the top and bottom.

Full

Displays images using the full width of the projection area, but
does not retain the aspect ratio. 4:3 ratio images are elongated
horizontally.

Through

Displays images as is (aspect ratio and resolution are maintained).
Black bands appear if the resolution is 1280 x 800 or less; images
are cut off if the resolution is over 1280 x 800.

Press the Aspect button repeatedly to cycle through the available
options.

You can also change the aspect ratio using the projector’s Signal

menu. See page 58 for details.
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Replacing the Batteries

The remote control uses two AA alkaline batteries. Follow these steps

when you need to replace them: note
) The remote control
1. Press in the tab to remove the battery cover. automatically shuts offwhen

it detects a button being
pressed more than

30 seconds. This conserves
battery life. It can be
helpful, for example, when
the remote is in a carrying
case and the O Power
button is accidentally
pushed.

caution
When replacing barteries,
take the following

precautions:

m Replace the batteries as
soon as they run out. If a
battery leaks, wipe away
battery fluid with a soft
cloth. If fluid gets on your
hands, wash them
immediately.

m Do not expose batteries to
heat or flame.

m Dispose of used batteries
according to local
regulations.

m Remove the batteries if
you won't be using the
remote control for a long

period of time.
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Fine-tuning the Projector

You can use the Menu button on the projector or remote control to

access on-screen menus to adjust the image, sound, and other features.

This chapter covers the following information:

Using the menu system

Adjusting image colors and clarity
Adjusting the input signal

Customizing projector features

Selecting projector setup options

Selecting projector network settings
Viewing lamp usage and other information
Using the projector’s security features

Restoring the default settings
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Using the Projector’s Menu System

The projector menus let you adjust and customize the projector

features:

54  Fine-tuning the Projector

The Image menu lets you modify the colors of the projected
image and fine-tune brightness, contrast, and sharpness. See

page 56.

The Signal menu lets you make adjustments to the input signal.
You can select your input source, change the image position and
aspect ratio, and adjust tracking and sync for computer images.
See page 58.

The Settings menu lets you customize the way you use the
projector. It allows you to adjust the volume and keystone
correction, set lamp brightness to high or low, control use of the
remote control receivers, project a test pattern for adjustments,
and disable buttons on the projector while you are projecting. See
page 60.

The Extended menu lets you customize the way you set up the
projector. Among the options, you can select the menu language,
set rear or ceiling projection, and record a custom image or logo
to be displayed as the startup screen or whenever you press the
A/N Mute button on the remote control. See page 62 and

page 60.

The Network menu lets you select your network settings and
optional passwords for monitoring the projector over a network
or over the web. See page 64.

The Info menu provides information about lamp status, and
computer or video settings. See page 64.

The Reset menu lets you restore the projector’s factory default
settings. See page 72.



Changing Menu Settings

Use the buttons on the remote control or on the projector to access
the menus and change settings. Follow these steps:

1. Press the Menu button on the remote control or projector to
display the menu screen:

Menu options

Image E
" Color Mode Presentation
Signal Brightness
Contrast
Settings Color Saturation
Tint
Menus — Extended Sharpness
Color Adjustment
Network Reset
Info
Reset
[[#1:Select [Enter]:Enter [Menul:Exit )

The menus are listed on the left, and the options available for the
highlighted menu are shown on the right.

. EPSON

2. Use the up and down arrow buttons on the projector or remote power % e
control to scroll through the menu list. When you’ve highlighted OO

the desired menu, press the Enter button on the projector or the y— B B
remote control to select it. —a—o—"
The highlight moves to the first option for that menu. %&S
A/VMute

3. Use the up and down arrow buttons on the projector or remote

—

control to scroll through the list of options. (The options available
depend on which source is selected.)

4. After highlighting the option you want to adjust, use the left or
right arrow buttons on the projector or the remote control to
change the setting. In some cases, you may have to press the Enter
button to see a sub-screen for changing the setting.

Fine-tuning the Projector 55



r Y — © Press the left or right arrow buttons on the projector or the
remote control to adjust a slider bar. To select from two or more
settings, use the up or down arrow buttons on the projector or the

:g: ; remote control to highlight the desired setting, then press Enter.

5. DPress the Esc button to return to the previous menu or to close
the menu system if you are at the main menu. Your changes are
saved automatically, however you may be prompted to restart the
projector to activate some settings.

6. Press the Menu button to exit the menu system.

Adjusting Colors and Clarity

The Image menu lets you make adjustments to the colors of the
projected image and fine-tune brightness, contrast, and sharpness.
The options available depend on which image source is selected:

Computer (analog-RGB)

and RGB video Image Return
b=  Color Mode Presentation
Signal Brightness 0
Contrast 0
Settings Sharpness o]
Color Adjustment
Extended Reset
Network
Info
Reset
[[[#1:Select [Enter]:Enter [Menul:Exit |
Component, .
composite, and S-Video |Image Return
" Color Mode Presentation
Signal Brightness
Contrast
Settings Color Saturation
Tint
Extended Sharpness
Color Adjustment
Metwork Reset
Info
Reset
[[[#1:Select [Enter] :Enter [Menul:Exit |
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Follow these steps to adjust the appearance of your image:

1.
2.
3.

Press the Menu button. You see the main menu.
Press Enter to select the Image menu.

Use the up and down arrow buttons and press Enter to set the
following options:

m Color Mode
Corrects the vividness of image color. You can select from the
following settings, and save a different one for each computer
and/or video source:

Game: Brightest mode, for playing video games in a bright
room.

Presentation: For color presentations in a bright room.
Text: For black and white presentations in a bright room.

Theatre: For optimizing movie images with natural color in a
dark room (the default for video or S-Video display).

Photo: For projecting still images with vivid color in a bright
room (Computer input only).

sRGB: For standard sSRGB computer displays (the default
when projecting from a computer with analog video).

Blackboard: Fixed color mode for projecting against a green

blackboard.
m Brightness
Lightens or darkens the overall image. note
You can also select High or
m  Contrast Low brightness mode in the
Adjusts the difference between light and dark areas. Settings menu. See page G1.

m Color Saturation (component, composite, and S-Video)
Adjusts the depth or intensity of the image colors.
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m Tint (component, composite, and S-Video)
Adjusts the balance of green to magenta in the image.

m Sharpness
Sharpens or softens the image.

m Color Adjustment
Adjusts the color temperature and intensity of red, green, and

blue.

4. When the image is set correctly, press Esc or Menu.

Adjusting the Input Signal

Although the projector normally detects and optimizes the input
signal automatically, you can use the Signal menu to manually select
it. You can also change the position of the projected image, correct
tracking and sync, and change the aspect ratio to widescreen format.

1. Press the Menu button. You see the Image menu.

2. Select the Signal menu. You see one of the following screens:

Image Image Return
. Auto Setup Position
Signal Resolution Signal Progressive
p———— Tracking b Computeri Input
Settings Sync. Settings Computer2 Input
Position Aspect
Extended Computeri Input Extended Reset
Computer2 Input
Network Aspect Network
Reset
Info Info
Reset Reset
(([#71:Select [Enter] :Enter [Menul:Exit ) (I$1:Select [Enter] :Enter [Menul:Exit )
Computer (analog-RGB) and RGB video Component video
Image Return
Position
Signal Progressive
=" Video Signal
Settings Aspect
Reset
Extended
Network
Info
Reset
([#71:Select [Enter] :Enter [Menu]:Exit )

Composite video and S-Video
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Press Enter. Then use the up and down arrow buttons and the
Enter button to set the following options:

B  Auto Setup (computer images)
Leave this setting On to automatically optimize the computer
image. Turn it off if you want to save adjustments you have
made to the video settings.

m  Tracking (computer images)
Removes unwanted vertical lines from a computer image by
matching the projector’s internal clock to various computer
signals. See page 88 for more information.

B Sync (computer images)

note

If you have repositioned the
image but then change your
mind, you can press the
Enter/Auto button on the
remote control to restore the
default settings.

Corrects fuzziness or screen flicker by synchronizing the
projector with the tracking signal sent from the computer.
See page 88 for more information.

m Position
Use the arrow buttons to move the image on the screen left,
right, up, or down.

m Progressive
Leave this setting On when viewing S-Video or composite
video so that interlaced-to-progressive conversion is carried
out (best for fast-moving pictures). If you notice flickering
while viewing still images, or you are using a component with
a 480i signal, switch this setting to Off.

m  Computer Input (1 or 2)
Selects the signal from equipment connected to the
Computer1 or Computer2 ports. If your image colors look
wrong, try changing this setting from Auto to one of the
following: RGB for computer or RGB video sources, or
Component Video for component video sources.
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m Video Signal (composite and S-Video)
Leave this setting at Auto unless you are using a 60-Hz PAL
system (select PAL6O).

m Aspect

Sets the image’s aspect ratio (ratio of width to height). Select
Auto, Normal, 16:9, Full, Zoom, or Through; see page 49

for details.

4. When you're finished, press Esc or Menu.

Customizing Projector Features

The Settings menu lets you customize the way you use the projector,

from adjusting lamp brightness and speaker volume to applying

security controls.

1.

Press the Menu button.

2. Select the Settings menu.

Image

Signal

Settings o}

Return

Keystone

Zoom

Control Panel Lock Full Lock
Brightness Control Low
Volume 0

Extended Remote Receiver Front/Rear
Test Pattern
Network Reset
Info
Reset
([#1:Select [Enter] :Enter [Menul:Exit J

3. Press Enter. Then use the up and down arrow buttons and the
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Enter button to set the following options:

m Keystone

Adjusts a distorted image from a trapezoid shape to

rectangular.

B Zoom

Adjusts the image size from Wide (larger) to Tele (smaller).



m Control Panel Lock

Disables all projector buttons (Full Lock) or all the buttons hote

| . . To cancel the Control Panel
except the O Power button (Partial Lock). You can still Lock finction from the
operate the projector from the remote control. Changes to projector, press the Enter
this setting take effect after you restart the projector. (After button for about seven

you turn off the projector, wait for the © Power light to turn  seconds.
a steady orange before turning it on again.)

m Brightness Control
Select Low lamp brightness when the projection is too bright
for the room. The Low setting also reduces electricity
consumption and fan noise. Select High to project the
maximum brightness. (Also check the Brightness setting in
the Image menu; see page 57.)

m Volume
Adjusts the volume for the projector’s speaker.

m Remote Receiver
Deactivates the projector’s front and/or back sensors that
detect signals from the remote control. This may be necessary
to prevent interference from bright fluorescent lights.

m Test Pattern
Displays a test pattern to assist you in focusing and zooming
the image, and correcting the image shape. (To cancel the
displayed test pattern, press Esc.)

When you’re finished, press Esc or Menu.
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Selecting Projector Setup Options

Use the Extended menu to customize the way you set up the
projector. You can configure the projector for rear and/or
ceiling/wall-mounted projection, change the language for the menus
and messages, set the screen background color, capture and store a

custom image or logo for the startup screen.

1.

Press the Menu button.

2. Select the Extended menu.

Image

Display
Signal User's Logo

Projection Front
Settings Operation

. Standby Mode Network Off

Extended [d] Language @) English
" Reset
Network
Info
Reset
[ [#1:Select [Enter] :Enter [Menul:Exit )

3. Press Enter. Then use the up and down arrow buttons and the

note

Captions are not visible
when you display the
projector menus or use EMP
Monitor to access the
projector over a network.
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Enter button to set the following options:
m Display
Messages: Lets you turn screen messages on or off.

Display Background: Sets the screen background to Black,
Blue, or Logo when no image signal is available.

Startup Screen: Enables or disables display of the startup
screen when the projector is turned on.

A/NV Mute: Sets the screen background to Black, Blue, or
Logo when the A/V Mute button is pressed.

Closed Caption: Turns on closed captioning using CC1 or
CC2.



User’s Logo
Turn on to display the image or logo you have captured
whenever the projector is turned on. See page 67 details.

Projection
Front: Projector is in front of the screen.

Front/Ceiling: Projector is in front of the screen, mounted
upside-down from a wall, whiteboard mounting, or ceiling.

Rear: Projector is behind the screen.

Rear/Ceiling: Projector is behind the screen, mounted
upside-down from the ceiling.

To change from Front to Front/Ceiling or Rear to
Rear/Ceiling, press and hold the A/V Mute button on the
remote control for five seconds.

Operation

Direct Power On: When this feature is enabled, projection
starts as soon as you plug in the power cord. You don’t have
to press the O Power button.

Sleep Mode: When enabled, the projector turns off the lamp
if it has not received any input signals for a period of time (as
defined in the Sleep Mode Timer setting).

Sleep Mode Timer: When Sleep Mode is on, you can set the
period of time before the projector turns off automatically,
from 1 to 30 minutes.

High Altitude Mode: When using the projector at an
altitude above 4,921 feet (1,500 m), turn this setting on to
ensure that the internal temperature of the projector is
regulated properly. Turn this setting off for lower elevations.

Standby Mode

Select Network On to allow the projector to be monitored
over a network when the projector is in standby mode (the
O Power light is orange).

Language
Select the language to be used for the projector menus.

4. When you’re finished, press Esc or Menu.

note

Logo settings cannot be
changed if the User’s Logo
Protect feature has been
turned on. See page 68.

note

When Direct Power On
is turned on, press the

O Power button to turn
the projector off; wait until
the O Power light turns a
steady orange, then unplug
the power cord.
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note

Selecting Network Settings

For information connecting the projector to a network and
monitoring the projector over a network, see “Monitoring the
Projector Over a Network” on page 93.

You can make changes to
many of the signal settings
on the Signal menu. See
page 58 for details.

Image
Signal
Settings
Extended
Network
[lnfo

Reset

Lamp Hours
High Brightness
Low Brightness
Source
Input Signal

Resolution
Refresh Rate
Sync Info
Status

Image Return
Wired LAN
Signal PJLink Password
Web Control Password
Settings SNMP
Mail
Extended Projector Name
AMYX Device Discovery Off
Network 0 Reset
Info
Reset

([#71:Select [Enter] :Enter [Menul:Exit |

Viewing Lamp Usage and Other

Information

Use the Info menu to view information about the display settings of
your computer and the number of hours the lamp has been used.

1. Press the Menu button.

2. Select the Info menu. You see one of the following menus:

Image
Lamp Hours
Signal High Brightness 0H
Low Brightness 0OH
Computeri Settings Source Computeri
Auto Video Signal Auto (----)
0x 1] Extended Status
0.00Hz

SGNN 00000 Network

[lnfo

Reset

[ T#1:Select

[Menul:Exit |

[Menu]:Exit ) [ [#171:Select

Computer (analog RGB, digital RGB, RGB

Video/Component video)

Video (Composite video, S-Video)
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m Lamp Hours
Displays the number of hours the lamp has been used. The
life span of the lamp ranges from about 3000 hours in High note

brightness mode to about 4000 hours in Low brightness The lamp usage timer
doesn’t register until you ve
used the lamp for at least
10 hours.

mode. If the number shown is close to 3000 or the
information is displayed in red, make sure you have a spare
lamp handy.

m  Source
Displays the input source currently being projected.

m Input Signal (computer, RGB video, and component video)
Displays the input signal setting.
m  Resolution (computer, RGB video, and component video)

Displays the input resolution.

m Video Signal (composite and S-Video)
Displays the video signal format.

m Refresh Rate (computer, RGB video, and component video)
Displays the refresh rate.

B Sync Info (computer, RGB video, and component video)
Provides information that may be needed by the service
technician.

m Status
Displays informations about projector problems. This
information may be needed if service is required.

When you’re finished, press Esc or Menu.

Fine-tuning the Projector 65



note

If you should happen to
enable the password before
you set one and you see the
prompt to enter the
password, enter the default
password 0000 ro proceed.

Using the Projector’s Security Features

To prevent unauthorized use of the projector, you can do the
following:

m  Create an identifying user logo that is displayed at startup and/or
when the A/V Mute button is pressed.

W Assign a password to prevent the projector from being turned on,
prevent your startup screen from being changed, and lock
network settings.

m  Disable the projector’s buttons; this is useful, for example, if
you’re projecting in a classroom and you want to ensure that no
one touches the projector’s buttons while you’re using the remote
control.

m Install an anti-theft lock or cable.

If you create a user’s logo for the projector, you can lock the logo on so
it is displayed as the startup screen and/or AV/Mute screen.
Unauthorized users cannot turn it off or change it. This feature is
intended to discourage theft and provides a way to identify the
projector should it be stolen.

If you assign the projector a password, a screen appears requesting the
password whenever the projector is turned on. If you enter the
password incorrectly three times in succession, the projector’s
operation is locked and you’ll need to disconnect the power cord, then
reconnect it to redisplay the password screen. If an incorrect password
is entered 30 times in a row, the projector is locked and you’ll need to
contact Epson to unlock it. See “Where To Get Help” on page 91.

If someone else will be using the projector for awhile but you want to
make sure that person returns it by a certain time, you can temporarily
disable the password for a set period. When that time has elapsed, the
password is reactivated and must be entered before the projector can

be used.

When you enable the Control Panel Lock feature, all of the projector’s
buttons (Full Lock) or all of the buttons except the O Power button
(Partial Lock) are disabled.
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Creating Your Own Screen Logo

You can transfer any image on your computer to the projector, and
then use it as the startup screen and/or the screen that is displayed
when you press the A/V Mute button. The image can be a company
logo, slogan, photograph, or any other image you want to use. The
projector considers this image the “User’s Logo.”

Follow these steps to capture the image and transfer it to the projector:

1. Display the image you want to use on the projector. You can use
an image from a computer or video source, such as a DVD player.

2. Press the Menu button and select the Extended menu.

note
If'the User’s Logo Protect
Image T
Display Junction is ON, you see a
Signal User's Logo
Projection R message that the {0go cannot
Settings Operation be recorded. You'll need to
. Standby Mode Network Off . >
Extended ld] Language &) English disable the cher.v Logo
——————" Reset Protect function before you
Network can create or change the
Info User’s Logo. See page 69.
Reset
[[[#1:Select [Enter]:Enter [Menul:Exit )

3. Use the down arrow button and press Enter to select User’s
Logo.

4. When you see a message asking if you want to use the present
image as a user’s logo, select Yes and press Enter. A selection box
displays over the image.

5. Use the arrow buttons on the projector or remote control to select
the area of the image you want to use. Once you have selected the
area, press Enter.

6. When you see the message Choose this image as the User’s
Logo?, choose Yes and press Enter. If you want to change the
area selected, select No, press Enter and repeat steps 5 and 6.
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note

The default setting for the
Startup Screen option
menu is On. If the Startup
Screen is set to Off, the
logo will nor display ar
startup.

If'the User’s Logo Protect
Sfunction has been set to On,
the Display Background
setting cannot be changed.
You need to turn the protect

Sfunction off first. See
page 69 for details.

Once you've saved a user’s
logo, you cannot reset the

logo setting ro its factory
default (no logo).

note

If a password has already
been set, you see the
Password Protect Release
screen. See “Starting the
Projector with a Password”
on page 70.

7. When you see this screen, select a zoom rate (display size), and
then press Enter.

[User's Logo]

Set the zoom factor.
Zoom factor:

0100% &
1200%
1300%

(TEscl :Return [#1:Select [Enter]:Set [Menul:Exit

8. When you see the message Save image as user’s logo?, select
Yes and press Enter. Saving the logo takes a few moments. Do
not use the projector or other sources (computer, video, etc.)
while the logo is being saved. When you see the message
Completed, press Esc.

9. To display the logo as the background screen when you press the
A/V Mute button or when no image signal is available, select the
Extended menu and press Enter. Then select Display, Display
Background, and Logo and press Enter. Select A/V Mute and
Logo and press Enter.

10. When you’re finished, press Menu to exit the menus.

Setting a Password

1. Press the Freeze button on the remote control for about five
seconds until you see the Password Protect menu:

[Password Protect]

Power On Protect BOFf
User's Logo Protect  Off
Metwork Protect Off

Password

[[#1:5elect [Enter]:Enter [Menul:Exit j

2. Select Password and press Enter.
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3. When you see the message Change the password?, select Yes

and press Enter.

Enter a 4-digit number using the numeric buttons on the remote
control, as shown.

The password will be displayed as ****. After you enter the last
digit, a confirmation screen appears. Enter the password again.
You see the message Password accepted.

After you finish setting the password, press the Esc button to
return to the Password Protect menu.

Make a note of the password and keep it in a safe place in case you

forget it.

Turning On the Password and User’s Logo

1.

5.

Press the Freeze button on the remote control for about five
seconds until you see the Password Protect menu.

To enable the password, select Power On Protect and press
Enter. Select On then press Esc.

To enable your screen logo, select User’s Logo Protect and press
Enter. Select On then press Esc.

When this feature is on the logo appears whenever the projector is
turned on (if the Startup Screen is enabled in the Extended
menu; see page 62) and as the A/V Mute screen (if you selected
the Logo as the Display Background in the Extended menu).
None of the User’s Logo features can be changed when the User’s
Logo Protect function is enabled.

To lock the network settings in the menu system, select Network
Protect and press Enter. Select On and press Enter.

Press Menu to close the Password Protect menu.

If you lose the remote control, you will not be able to enter the

password, so keep the remote control in a safe place at all times.

You can attach the password protect sticker to the projector as an
additional theft deterrent.

Numeric

buttons |

Source
Power Ssearch  Help

Menu A Esc

Vol— Enter/Auto Vol+

ColorMode Aspect

v
+ — Freeze
% A/VMute

S ———
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Starting the Projector with a Password

When the password function is enabled, you see this screen when you
turn on the projector:

[Password]

Enter the password.

See your docunentation for more information.

[ [0-91:Enter

Use the numeric buttons on the remote control to enter the password.
Once you have entered the password correctly, the password screen
closes, and projection begins.

If the password is not correct, you see the message Wrong password.
Please try again. If you enter an incorrect password three times in
succession, you see the message The projector’s operation will be
locked. Request code xxxxx and the projector switches to standby
mode for approximately 5 minutes. Write down the request code.
Then disconnect the projector’s power cord from the electrical outlet,
reconnect it, and turn the projector back on.

When you see the Password Protect Release screen again, you can try
to enter the correct password.

If you enter an incorrect password 30 times in succession, the
projector remains locked and you must contact Epson for service.

If you have forgotten the password, contact Epson with the request
code number that appears in the Password Protect Release screen for
assistance. See “Where To Get Help” on page 91.
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Disabling the Projector’s Buttons

You can use the Control Panel Lock function to disable all the
projector’s buttons, or all the buttons except for the © Power button.

note
1. Press the Menu button. T camcel Conirol Panel
2. Select the Settings menu and press Enter. Lock, press the projector’s

Enter button for 7 seconds.
3. Use the up and down arrow buttons to select Control Panel Lock

and press the Enter button.

4. Select Full Lock to disable all the buttons, or Partial Lock to
disable all except the O Power button. Then press Enter.

5. Select Yes and press Enter to confirm the setting.

6. Press the Menu button.

Installing Security Locks

You can install two different types of security locks on the projector:

B You can use the security slot on the base of the projector to install
a Kensington Microsaver Security System. See page 13.

B You can use a wire lock to secure the projector to a room fixture
or heavy furniture, as shown below.
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note

The Computer Input (1 and
2), User’s Logo, Network
menu settings, Lamp Hours,
and Language settings do
not return to their defaults
when you select Reset All.
To reset the computer
inputs, use the Reset option
on the Signal menu; see
page 58 for details. To reset
the network settings, use the
Reset option on the
Network menu; see page 64
Jor details. To reset the
Language settings, use the
Reset option on the
Extended menu; see page 62
Jfor details.

Restoring the Default Settings

The Reset menu lets you return most projector menu settings to their
default values. It also lets you reset the lamp hours to their initial
default value; see page 79 for instructions on resetting the lamp timer.

Image
Reset All

Signal Reset Lamp Hours

Settings

Extended

Network

Info

[Reset

[ [#1:Select [Enter]:Enter [Menul:Exit j

To reset most projector menu settings, select Reset All and press the
Enter button to display the confirmation screen. Select Yes to reset all
the default settings or No to cancel.
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Maintenance and
T ransportation

Your projector needs little maintenance. All you need to do on a
regular basis is keep the lens clean. Any dirt or smears on the lens may

warning show up on your projected image.

Before you clean any part of

the projector, turn it off and You may need to clean the air filter and air vents. A clogged air filter
unplug the power cord. or air vent can block ventilation needed to cool the projector and
NEZ/EV 0P€n ﬂ”}/ cover on tbe cause OVCl‘hCating.

projector, except the lamp

and filter covers. Dangerous The only parts you should replace are the lamp and air filter. If any
electrical voltages in the other part needs replacing, contact your dealer or a qualified servicer.
projector can injure you . )
severely. Do not try to service This chapter covers the following:
this product yourself, except
as specifically explained in
this User’s Guide. Refer all m  Cleaning the projector case
other servicing to qualified

SKVViC€P€750ﬂﬂ€l.

m  Cleaning the lens

m  Cleaning and replacing the air filter
m  Replacing the lamp
m  Resetting the lamp timer

m  Transporting the projector
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caution
Do not use glass cleaner ro
clean the lens.

Avoid touching the lens with
your bare hands to prevent
[fingerprints on or damage to
the lens surface.

Cleaning the Lens

Clean the lens whenever you notice dirt or dust on the surface.
B Use a canister of compressed air to remove dust.

m  To remove dirt or smears on the lens, use lens-cleaning paper. If
necessary, moisten a soft cloth with lens cleaner and gently wipe

the lens surface.

Cleaning the Projector Case

Before you clean the case, first turn off the projector and unplug the
power cord.

B To remove dirt or dust, wipe the case with a soft, dry, lint-free

cloth.

B To remove stubborn dirt or stains, moisten a soft cloth with water
and a mild detergent. Then wipe the case.

B Do not use wax, alcohol, benzene, paint thinner, or other
chemical detergents. These can damage the case.

Cleaning and Replacing the Air Filter

Your projector includes an air filter to ensure the best performance. If
dust collects on the air filter or vent on the side of the projector, clean
them as described below. Dust clogs prevent proper ventilation and
can cause overheating and damage the projector.

When the filter and vent are clogged, the projector displays the
message The projector is overheating. Make sure nothing is
blocking the air vent, and clean or replace the air filter.
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To clean the air filter and air vent, follow these steps:

1.

Turn off the projector, allow it to cool down, and unplug the
power cord.

To clean the filter and vent, Epson recommends using a small
vacuum cleaner designed for computers and other office
equipment. If you don’t have one, gently clean them using a very
soft brush (such as an artist’s paintbrush).

You can remove the air filter to clean both sides.

If the dirt is difficult to remove or if the filter is torn, replace it.
Contact your dealer or call Epson at (800) 463-7766 to obtain a
new one (part number VI3H134A13).

If you need to clean or replace the filter, slide it out, as shown.

Maintenance and Transportation
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note

Air filters contain
polycarbonate, ABS resin,
and polyurethane foam.
Dispose of used air filters
according o local
regulations.

note

You can check to see how
many hours the lamp has
been used. See page 64.

Turn off this product when
not in use to prolong the life
of the projector.

warning

Let the lamp cool before
replacing it. If the lamp
breaks, handle the shards
carefully to avoid injury.

4. Align the new filter and slide it in undil it clicks into place.

Replacing the Lamp

The projection lamp typically lasts for about 3000 hours of use
(in high brightness mode) or 4000 hours (in low brightness mode). It
is time to replace the lamp when:

m  The projected image gets darker or starts to deteriorate.
B The & lamp light is flashing orange.

M The message Replace the Lamp appears on the screen when the
lamp comes on. To maintain projector brightness and image
quality, replace the lamp as soon as possible.

Contact your dealer or call Epson at (800) 463-7766 for a
replacement lamp. Request part number V13H010L42.

Follow these steps to replace the lamp:

1. Press the O Power button twice to turn off the projector. When
you hear the projector beep twice, unplug the power cord.

2. If the projector has been on, allow it to cool down for at least an
hour (or until the lamp is cool).
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3. Use the screwdriver included with the replacement lamp or a
#2 Phillips-head screwdriver to loosen the screw holding the lamp
cover (the lamp cover is located on top of the projector).

4. Slide the cover out, then lift it off.

5. Use the screwdriver to loosen the two screws holding the lamp in

place. (You can’t remove the screws.)

6. Hold the lamp as shown and pull it straight out. note
The lamp(s) in this
Q product contain mercury.
Don't remove
Please consult your state and
these screws

local regulations regarding
disposal or recycling. Do nor
put in the trash.
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caution

Do not touch the glass
portion of the lamp
assembly. Touching the glass
could result in premature

lamp failure.

note

Be sure o seat the lamp fully
and secure the lamp cover. If
the lamp is not properly
installed or the cover is loose,
the lamp will not turn on.

7. Gently insert the new lamp along the guide rail. If it doesn’t fit
easily, make sure it’s facing the correct way. Push the lamp down
firmly where the label PUSH appears.

8. Once the lamp is fully inserted, tighten its screws.

9. Lower the lamp cover into place. (The opening should be almost
covered, and the top of the cover should be flush with the top of
the projector.) Then slide the cover closed and tighten the screw.

10. Reset the lamp timer as described in the next section.
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Resetting the Lamp Timer

You must reset the lamp timer after replacing the lamp to clear the
Replace the Lamp warning message. Follow these steps:

1. Connect the power cable and turn on the projector.

2. Press the Menu button on the remote control or projector and
select the Reset menu. Then press Enter.

Image
Reset All

Signal Reset Lamp Hours

Settings

Extended

Network

Info

[Reset

([%71:Select [Enter] :Enter [Menul:Exit |

3. Select Reset Lamp Hours and press Enter. You see a
confirmation screen.

4. Select Yes and press Enter.

5. Press Esc to return to the main menu or the Menu button to exit

the menu system.

note

Do not reset the lamp timer if
you have not replaced the
lamp. If you do, the Lamp
Hours will not accurately
reflect the number of hours
that the lamp has been used.
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Transporting the Projector

The projector contains many glass and precision parts. If you need to
transport it, please follow these packing guidelines to prevent damage
to the projector:

B Whenever you transport the projector, always attach the lens
cover and the protective pad that fits over the lens cover to protect
the lens.

m  When shipping the projector for repairs, use the original
packaging material if possible. If you do not have the original
packaging, use equivalent materials, placing plenty of cushioning
around the projector.

note

Epson shall not be liable for B When transporting the projector as freight or checked luggage,
any damage incurred during first put it in a carrying case, then pack it in a firm box, using
transportation. cushioning around the case. Make sure the shipping carrier is

equipped to handle fragile equipment and mark the box “Fragile.”

B When you are hand-carrying the projector, be sure to use a
carrying case.
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Solving Problems

This chapter helps you solve problems with your projector, and tells

you how to contact technical support for problems you can’t solve

yourself. This chapter explains the following:

Using the projector’s on-screen help system

What to do when the projector’s status lights flash

Solving problems with the image or sound

Solving password problems

Solving problems with the remote control

Solving problems monitoring the projector over a network

Contacting technical support
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Using On-Screen Help

If the image doesn’t look right or your audio isn’t working, you can
get help by pressing the ? Help button on the projector or remote
control.

1. Press the ? Help button on the remote control or projector. You
see the Help menu.

2. Use the up and down arrow buttons on the projector or remote
control to highlight the problem you want to solve. Then press
the Enter button to view the solution(s).

3. Press Esc to view another topic or press ? Help to exit.

If none of the suggestions solves your problem, see additional
solutions to problems in the following sections.

What To Do When the Lights Flash

The lights on top of the projector indicate the projector’s status and
let you know when a problem occurs.

Power light

Lamp light e

Temperature
light o OOO
[

N

If the projector is not working correctly, first turn it off and unplug it.
Then plug the power cord back in and turn on the projector. If this
does not solve the problem, check the status lights on top of the
projector and try the solutions recommended in the following table.



Power
light

Lamp
light

Temperature
light

Description

Green

Off

Off

The projector is operating normally.

Flashing
green

Off

Off

The projector is warming up. Wait for the image to appear.

Orange

Off

Off

The projector is in standby or sleep mode. You can unplug
it or press the O Power button to turn it on.

Flashing
orange

Off

Off

The projector is shutting down. Wait for the light to stop
flashing and remain orange before unplugging it.

Red

Off

Flashing
orange

The projector is too hot. Make sure the temperature
surrounding the projector does not exceed 95 °F (35 °C)
and there is plenty of space around and under the projector
for ventilation. Clean the air filter and air vents, if
necessary. See page 74 for instructions.

Red

Off

Red

The projector has overheated and turned itself off. Let it
cool for about five minutes, then turn it back on. Make sure
there is plenty of space around and under the projector for
ventilation. If you are using the projector at an altitude
above 4921 ft (15600 m), turn on High Altitude Mode as the
Operation setting in the Extended menu; see page 62. Also
clean the air filter and air vents; see page 74. If it continues
to overheat, you may need to replace the air filter.

Red

Flashing
red

Off

The lamp is burned out, broken, or not installed correctly;
or the lamp cover is open. Close the cover or replace or
reseat the lamp, if necessary, as described on page 76.
Also clean the air filter and air vents; see page 74. If you
are using the projector at an altitude above 4921 ft

(1500 m), turn on High Altitude Mode as the Operation
setting in the Extended menu; see page 62. If these
suggestions don't work, contact Epson.

Orange

Flashing
orange

Off

Replace the lamp with a new one as soon as possible; see
page 76 for instructions. If you continue to use the lamp,
there is a risk it may break.

Red

Off

Flashing red

There is a problem with the fan or a sensor. Turn the
projector off and unplug it. Contact Epson for help; see
page 91.

Flashing
red

Flashing
red

Flashing red

There is an internal error in the projector. Turn the projector
off and unplug it. Contact Epson for help; see page 91.
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Solving Problems with the Image or
Sound

No image appears on the screen.

Check that the ® Power light is green, not flashing, and the lens
cover is removed. Also press the A/V Mute button on the remote
control to see if the picture was turned off temporarily.

If the projector doesn’t turn on, the Control Panel Lock may be
enabled. Press and hold the Enter button on the projector for
7 seconds to release the lock.

The projector may be in standby or sleep mode. If the projector
has not received any signal for 30 minutes, it turns off the lamp to
conserve the lamp life and save energy. If the O Power light is
orange, press the O Power button to turn on the projector.

The attached computer may also be in sleep mode or displaying a
black screen saver. Try pressing a key on the computer.

If the power was switched off and then on again, wait until the
O Power light stops flashing and remains orange. Then press the
O Power button again.

Check the Video Signal, Computer1 Input, or Computer2
Input setting in the Signal menu to make sure it is correct for the
selected source. See page 58 for more information.

Messages may have been turned off in the Display setting of the
Extended menu. See page 62 for details.

Adjust the Brightness setting on the Image menu (see page 57)
or select High for the Brightness Control setting in the Settings
menu (see page 61).

With Direct Power On enabled in the Operation setting of the
Extended menu, if you unplug the projector and then plug it right
back in, you must press the O Power button to turn on the
projector. See page 62 for details.

Make sure at least one of the projector’s remote receivers are
turned on in the Settings menu. See page 60 for details.



Nothing appears on the external monitor.

Make sure the VGA computer cable is connected to your
computer’s video port and the projector’s Computer1 port.

Make sure the cable from your monitor is connected to the
projector’s Monitor Out port.

You see a blue screen with the message No Signal displayed.

Make sure the cables are connected correctly, as described in

Chapter 1.

Make sure the power to your computer or video source is
turned on.

If you've connected a computer and one or more video sources,
you may need to press the Source Search button on the
projector or the remote control to select the correct source. Allow
a few seconds for the projector to sync up after pressing the
button.

If you've connected a laptop computer, make sure it’s set to
display on an external monitor. See page 38.

The message Not Supported is displayed.

Make sure your computer’s resolution doesn’t exceed WXGA+
and the frequency is supported by the projector; see page 109. If
necessary, change your computer’s resolution setting as described
on page 80.

Make sure the correct Video Signal is selected in the Signal
menu. See page 60. It should normally be set to Auto.

The buttons on the projector don’t work.

The Control Panel Lock may be enabled. Press and hold the Enter
button on the projector for 7 seconds to release the lock.
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Only part of the computer image is displayed.

If you’re projecting from a computer or RGB video device, press
the Enter/Auto button on the remote control. If this doesn’t
work, you may need to adjust the Position setting in the Signal
menu. See page 59 for more information.

If you’ve enlarged part of the image using the E-Zoom button on
the remote control, press the Esc button to cancel zooming and
return to full display.

Try pressing the Aspect button on the remote control to select a
different aspect ratio. See page 49 for details.

Make sure your computer’s resolution setting is correct and dual
display is not activated. Ideally, it should be 1280 x 800 to match
the projector’s native resolution. If this option isn’t available,
select another compatible video format. See page 109.

m  Windows:
Right-click the desktop, select Properties, click the Settings
tab, and select a different resolution.

B  Macintosh OS X:
On the Apple menu, choose System Preferences, then
click Display or Displays. Select a different resolution.

You also may need to modify existing presentation files if you
created them for a different resolution. See your software
documentation for specific information.

The image isn’t rectangular, but trapezoid-shaped.

Make sure the projector isn’t placed off to one side of the screen,
at an angle, or the image won’t be rectangular. Place it directly in
front of the center of the screen, facing the screen squarely.

If you've tilted the projector upward, the image will be broader at
the top. Hold down the /X' or "\_/ buttons on top of the
projector until the image is rectangular.



The image contains static or noise.

If you’re using a computer cable longer than 6 feet (2 m), or an
extension cable, the image quality may be reduced.

Keep your computer and video cables separated from the power
cord as much as possible to prevent interference.

The video signal may be split between the computer and the
projector. If you notice a decline in the projected image quality
when the image is displayed simultaneously on your laptop
computer and the projector, turn off the laptop’s LCD display.

If you’re projecting from a composite or S-Video source, check
the Video Signal setting in the Signal menu. In most cases, leave
it set at Auto. If you’re using a 60-Hz PAL video source, change
this setting to PALB0. Also make sure the Progressive setting is
On. See page 60 for details.

Make sure the cables are securely connected at both ends.

Select the correct resolution; see “Compatible Video Formats” on

page 108.

If you're projecting from a computer, press the Enter/Auto
button on the remote control or the Enter button on the
projector to adjust tracking and sync automatically. If that doesn’t
work, try adjusting the Sync and Tracking settings in the Signal
menu. See page 59.

The image is blurry.

Adjust the focus using the focus ring. See page 40.
Try cleaning the lens as described on page 74.

Make sure the lens is not fogged by condensation. You may need
to wait before using the projector after moving it from a cold
environment.

Make sure the projection distance is within the ranges described
on page 16 through page 18.

Adjust the Sharpness setting on the Image menu (see page 58).
You should be able to see the effect on the screen immediately.
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You see vertical stripes or the image still looks blurry after
trying the solutions in the previous section.

If you’re projecting from a computer and displaying an image that
contains a lot of fine detail, you may notice one or more vertical
stripes or bands, or some of the characters may look heavy or
blurred. Press the Enter/Auto button on the remote control to
automatically reset the projector’s tracking and sync settings.

If necessary, you can manually adjust the Tracking and Sync
settings on the Signal menu as described on page 59.

To help you adjust these settings, fill the screen with a detailed
image, such as a desktop background pattern or black text on a
white background. Adjust the Tracking setting to eliminate
vertical stripes; adjust the Sync setting to increase the sharpness.

The colors of the image are not right.

|
note
Because of the different
technologies used, your [ ]
projected image may not
exactly match the colors on
your laptop or computer u
monitor.
|
|
|
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Try selecting a different Color Mode. See page 57 for

instructions.

If you’re displaying video, adjust the Color Saturation and Tint
settings on the Image menu. See page 57 for instructions.

Adjust the Brightness, Contrast, and Color Adjustment
settings on the Image menu. See page 57.

Make sure the input signal setting on the Signal menu matches
the signal from the connected device. See page 58 for details.

If the image is too purple and you’ve connected a computer or
other RGB device to the Computer1 or Computer2 port, select
RGB as the input source. If you've connected a component video
device to one of these ports, select Component Video.

If you’re projecting from a composite video or S-Video source,
select the correct Video Signal in the Signal menu.

Check your computer display settings to correct the color balance.

If the image seems dark, the lamp may be nearing time for
replacement. Check the lamp hours as described on page 64 and
replace the lamp, if necessary, as described on page 76.



There is no sound.

B Press the Vol+ button on the remote control to turn up the
volume.

m Ifyou've turned off the picture and sound, press the A/V Mute
button on the remote control to turn them on again.

m Ifyou're using a DVD player or other video source, make sure its
volume is not turned all the way down or muted. Also, make sure
the cables are connected correctly, as described in Chapter 1.

B Make sure the audio cable is connected to the correct audio port.
See page 24 or page 31.

m  Ifyour presentation includes computer audio, make sure the
volume control on your computer is not turned all the way down
or muted. Make sure the audio cable is securely connected to both
the projector and your computer. See page 24.

B The wrong source may be selected. Press the Source Search
button on the projector or the remote control.

Solving Password Problems

You have forgotten the password.

B Write down the request code that appears in the Password Protect
Release screen and contact Epson. See page 91.

m Ifyou turned on the password protect feature before setting the
password and no password was set before, try using the default
password: 0000.

The remote control is not available.

You must have the remote control to enter the password. You can
purchase a replacement remote control from Epson. See page 92.
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Solving Problems with the Remote
Control

The projector doesn’t respond to remote control commands.

m  Make sure you are within 20 feet (6 m) of the projector, and
within range of the projector’s front or back sensor. The effective
range is approximately 30° to the left or right, 30° above or below
the rear sensor, and 60° above the front sensor (below, if mounted
upside-down).

30°

----{m !

; 4 300 \ 0000 :
I I I | I
I I I | I
I I I | I
[ —————p| |
I 20 feet ! ! 20 feet | 1 20 feet ! ! 20 feet !

6 m) 6 m) "oBm) (6 m)

m Ifabutton on the remote control is held for more than
30 seconds, the remote enters sleep mode. Press another button
for normal operation.

m  The remote control batteries may not be installed correctly or may
be low on power. Replace the batteries as described on page 51.

m  Dim the room lights and turn off any fluorescent lights. Make
sure the projector is not in direct sunlight. Strong lighting,
especially fluorescent lights, may affect the projector’s infrared
receivers. If you still have trouble using the remote control, disable
one of the remote receivers using the Settings menu to block
interference from bright light. See page 60 for details.

m  Turn off any nearby equipment that emits infrared energy, such
as a radiant room heater.

You have lost the remote control.

You need the remote control to access many projector features. If you
have lost it, you can order another from Epson; see page 92 for details.
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Solving Network Problems

You don’t see your projector in the EMP Monitor window.

B Make sure that you've connected the projector to the network and
configured it correctly; see page 95. Also, make sure you've
registered the projector with EMP Monitor; see page 99.

B Make sure that Standby Mode in the projector’s Extended menu
is set to Network On; see page 62.

m  If the computer you are using is running Windows XP or 2000,
or Windows Vista;” you must be logged in as the Administrator.

m  Try restarting your computer.

You don’t receive an e-mail over the network when a
projector problem occurs.

B Make sure that Standby Mode in the projector’s Extended menu
is set to Network On; see page 62.

B Make sure that you've connected the projector to the network and
configured it correctly; see page 95.

B Make sure you set up projector e-mail alerts correctly in the
Network menu (see page 97) or in EMP Monitor (see page 102).

Where To Get Help

Epson provides these technical support services:

Internet Support

Visit Epson’s support website for solutions to common problems with
the PowerLite 400W. You can download utilities and documentation,
get FAQs and troubleshooting advice, or e-mail Epson with your
questions.

Visit Presenters Online to access tips, templates, and training for
developing successful presentations.
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http://www.epson.com/cgi-bin/Store/support/supDetail.jsp?sku=V11H281020
http://www.presentersonline.com

note

To purchase a replacement
remote control, call

(562) 276-4394 (U.S.) or
(905) 709-3839 (for dealer
referral in Canada).
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Speak to a Support Representative

To use the Epson PrivateLine Support service, call (800) 637-7661
and enter the PIN on the included Epson PrivateLine Support card.
This is the fastest way of speaking to a live representative, and it’s free.
This service is available 6 AM to 6 PM, Pacific Time, Monday through
Friday, for the duration of your warranty period.

You may also speak with a projector support specialist by dialing one
of these numbers:

m U.S.: (562) 276-4394, 6 AM to 6 PM, Pacific Time, Monday
through Friday

m  Canada: (905) 709-3839, 6 AM to 6 PM, Pacific Time, Monday
through Friday

Days and hours of support are subject to change without notice. Toll
or long distance charges may apply.

Before you call, please have the following information ready:

B Product name (PowerLite 400W)

B Product serial number (located on the bottom of the projector)
B Proof of purchase (such as a store receipt) and date of purchase
m  Computer or video configuration

m  Description of the problem

Purchase Supplies and Accessories

You can purchase screens, carrying cases, or other accessories from an
Epson authorized reseller. To find the nearest reseller, call
800-GO-EPSON (800-463-7766). Or you can purchase online at

www.epsonstore.com (U.S. sales) or www.epson.ca (Canadian sales).


http://www.epsonstore.com
http://www.epson.ca

Monitoring the Projector
Over a Network

The software included with your projector lets you monitor and

control your projector over a network.

Use EMP Monitor (available for Windows only) to see your
projector’s status, switch image sources, and control basic settings.

Use the mail notification function to receive e-mail alerts about
possible problems.

To use the software to manage your projectors, first install EMP

Monitor. Then connect and configure the projector you want to

monitor as described here.

This chapter covers the following information:

Installing the network software

Connecting your projector to a network

Selecting network settings

Monitoring and controlling your projector with EMP Monitor

Using a browser to monitor the projector
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Installing the Network Software

The network software CD-ROM includes the software you need to

monitor the projector from a remote location. The Epson Projector
Software CD-ROM includes EMP Monitor for monitoring the
projector from a remote location.

Windows System Requirements

Before you install the software, make sure your computer meets these

requirements:

Microsoft Windows 98SE, Me, or 2000 (SP4), Windows XP, or
Windows Vista

IBM® compatible PC with at least a Pentium® IIT 1.2 GHz
processor

At least 256MB of RAM (512 recommended)
At least 128MB of free hard disk space

XGA (1024 x 768) or better display adapter and monitor, 16-bit
color or higher

Installing the Software on a Windows System

1.

Insert the network software CD-ROM in your computer’s
CD-ROM or DVD drive.

Click Custom, then make sure EMP Monitor is selected.

Click Install, then follow the on-screen instructions to install
your projector software.

When installation is complete, click Exit.
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Connecting to the Network

Follow these steps to connect the projector to your network and

configure it with an IP address.

1. Connect the projector to your network using a commercially
available 100BaseTX or 10BaseT network cable. Connect the
cable to the LAN port on the projector.

2. Press the projector’s O Power button to turn it on.
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Selecting Network Settings

Follow the instructions in this section to set up the projector’s
network settings in the menu system.

1. Press the Menu button.

2. Select the Network menu.

Image Return
Wired LAN
Signal PJLink Password
Web Control Password
Settings SNMP
Mail
Extended Projector Name
. AMX Device Discovery Off
Network 4] Reset

Info

Reset

([#71:Select [Enter] :Enter [Menul:Exit |

3. Press Enter. Then use the up and down arrow buttons and the
Enter button to set the following options:

m  Wired LAN
If your network assigns addresses automatically, turn on the
DHCP setting.

If your network does not assign addresses automatically, turn
off DHCP and enter the projector’s IP Address, Subnet
Mask, and Gateway Address as needed.

To enter numbers, use the numeric buttons on the remote
control.

m PJLink Password
Lets you enter a password for using the PJLink™ protocol to
control the projector.

m  Web Control Password
Lets you enter a password for accessing the projector over the
web from a computer running the EMP Monitor software.

96 Monitoring the Projector Over a Network



m SNMP

If you’re a network administrator, you can use the SNMP
option to enter trap IP addresses. This lets you receive trap
alerts for the projector on a computer running the SNMP
Manager software.

m  Mail

When enabled, the projector sends you an e-mail alert if it has
any problems. For instructions on setting up e-mail alerts, see
the next section.

m Projector Name

Enter a name for identifying the projector over the network.

m AMX Device Discovery
Turn on to allow the projector to be detected by AMX®
Device Discovery-enabled software, if you are using it on
your network.

Using Projector E-mail Alerts

When this feature is enabled, the projector sends you an e-mail alert if

it has any problems.

1.

note
Press the Menu button, select the Network menu, and press

Enter. from EMP Monitor (see

Select Mail and press Enter. page 102).

Select the following settings as necessary:

m  Mail Notification
Select On to enable sending of an e-mail if there is a problem
with the projector.

m  SMTP Server
Enter the IP address for the SMTP server for the projector.
You can enter a number from 0 to 255 in each field of the
address.

m  Port Number
Enter the SMTP server’s port number. The default value is
25. You can enter a numeric value from 1 to 65535.

Monitoring the Projector Over a Network
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note

Ifa critical problem develops
with a projector which
causes it to suddenly stop
working, it may not be
possible for the projector to

send a message.

If Standby Mode is set to
Network On in the
Extended menu, the
projector can still be
monitored even if the
projector is in standby mode
(when the power is off).

note

If you want to monitor the
projector while it is in
standby mode, select
Standby Mode in the
Extended menu, then select
Network On. See page 62.

m Address 1/2/3 Setting
Choose one of the Address numbers, then enter the e-mail
address where you want to receive a message when a problem
occurs and select the condition under which you want to

receive a message.
4. When you’re done, press Menu to exit the menu system.

When a problem occurs, an e-mail message is sent to the specified
addresses with the subject line EPSON Projector and the following
information:

m Line 1: The name of the projector where the problem has
occurred

m  Line 2: The IP address of the projector where the problem has
occurred

m  Line 3: Details of the problem

Using EMP Monitor

EMP Monitor lets you use a remote computer to manage your
projectors. It lets you easily turn the projector on or off, switch image
sources, and check its status.

Before using EMP Monitor, make sure you've installed the software
(available for Windows only) as described on page 94. The computer
you’re using to monitor the projector should already be connected to
your network.

Opening and Closing EMP Monitor

To start EMP Monitor, click Start > Programs or All Programs >
EPSON Projector > EMP Monitor.

If you’ve added the program to the Startup programs folder, it may
already be open. If so, click the icon in the system tray on the
lower-right corner of your screen to start EMP Monitor:

Click here to start

|
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To close EMP Monitor, select Exit from the File menu or right-click

the program icon shown above, then select Exit.

Registering a Projector

Before you can monitor a projector, you have to register it. Follow

these steps to automatically search for your projector.

1.
2.
3.

Open EMP Monitor.
Select Edit > New > Projector (automatic search).

Click Search to locate projectors currently operating on the
network.

Select the projector you want to add by clicking its name, then
click the Edit button.

Enter a Display name, select a Parent group, if necessary, enter a
Monitor Password, if necessary, and a Description for the
projector.

Click the Register button.

Repeat steps 2 through 5 to register any additional projectors on
the network.

When you’re done adding the projector, click Cancel. You see a
screen with a list of all registered projectors:

Monitoring Your Projector

The EMP Monitor screen lets you monitor your projector status and

check if a problem has occurred.

For the most current status, click the Refresh button.

note

If the projector is not
automatically found, your
projector may not be
connected or configured
correctly for the network. See
page 95.

To delete a projector from
the list, right-click the
projector name, and click
Delete.

note

To monitor a projector
when it’s in standby mode
(plugged in but not turned
on), you must select
Network On as the
Standby Mode serting in
the projector’s Extended
menu (see page 62).

For detailed status
information, right-click the
projector and click
Property.
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The following table describes the EMP Monitor status icons.

Group status icons

No warnings or problems in the projector group.

Warning or problem in a projector in the group.

Monitoring disabled. Right click the icon and select
Monitoring Enabled to begin monitoring the group.

@

Data is currently being updated.

Type status icons

No warnings or problems.

Warning or problem.

#
&

Monitor Password error. No monitor password was
entered when you registered the projector, or an
incorrect password was entered.

Monitoring disabled. Right-click the icon and select
Monitoring Enabled to monitor the projector.

§

Data is currently being updated.

&)

Network error (projector is not connected to the
network, the power cable is disconnected, or
Network Off is selected as the Standby Mode
setting in the Extended menu; see page 62).

~

f

&)

Network error (Esc/VP.net communication error).

Power status icons

The projector is powered on; normal status.

The projector is powered off; normal status.

The projector is powered on; abnormal status.

960 e 0

The projector is powered off; abnormal status.
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Temperature level status icons

(A | The projector’s internal temperature is normal (low).

T The projector’s internal temperature is normal
(medium).

T 1 The projector’s internal temperature is normal (high).

CT T 1T | The projector’s internal temperature is high
(high-temperature warning).

The projector’s internal temperature is too high
(high-temperature error). The projector is turned off

automatically.

Error status icons

a Lamp life warning. The lamp is nearing the end of its
life.
Iﬂ High-temperature warning. The projector is getting
too hot but continues to operate.
@ Replace air filter.
= No air filter. The air filter is not installed or installed
=] incorrectly.

Low air flow. The air filter needs to be cleaned or
replaced.

o

Air flow sensor error. Contact Epson as described on
page 91.

I

a1l

Lamp cover open. Close the lamp cover.

4
—
L

Lamp out. The lamp has reached the end of its life.

“

Lamp failure at power on. The lamp has reached its
end of life or is installed incorrectly.

@

High internal temperature error. The projector is
turned off automatically.

=

Internal (system) error. Contact Epson as described
on page 91.

(5]
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note
You can also set e-mail alerts
[from the projector’s menu

system (see page 97).

note

If a projector develops a
critical problem, it may nor
be possible for it to report the

error.

!.'r'-ﬂ Fan error. Contact Epson as described on page 91.

)
lp1 Sensor error. Contact Epson as described on
2 page 91.

Other error. Contact Epson as described on page 91.

Using E-mail Alerts

You can set up e-mail alerts to warn you of problems with the

projector.

1. Open EMP Monitor.

2. From the Tool menu, select Mail notification function.

3. Turn the Mail notification function setting On.

4. Enter the IP address and port number of your network’s SMTP
(outgoing) mail server.

5. Enter the Sender (projector) mail address.

6. Enter up to three e-mail addresses to send alerts to in the
Recipient mail address boxes.

7. Click the Notification event buttons to select the conditions
under which an e-mail alert will be sent.

8. When you’re done, click the OK button.

If a projector experiences a problem, EMP Monitor sends an e-mail

message to each of the addresses you entered in the Set mail

notification function window. The subject line and body of the

message includes the projector’s name and the warning or error

(similar to the those listed on page 99).

When the problem has been fixed, EMP Monitor sends a message
indicating the problem has been resolved.
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Using a Browser to Monitor the
Projector

If your projector is connected to a network, you can use a standard

web browser to monitor and control it. When using a browser to

access the projector, you cannot connect through a proxy server.

1.

Make sure that the projector is connected to your network, as

described on page 95.

Follow the instructions on page 62 to set Standby Mode to
Network On in the Extended menu so you can monitor the
projector in standby mode.

Open your web browser and enter the IP address of the projector
you want to monitor in the browser window.

If you’re not sure what the address of the projector is, turn the
projector on and select Wired LAN from the Network menu to
display the IP address of the projector. See page 96.

You see a login screen.
Do one of the following:

m Ifyou didn’t set a Web Control Password in the Network
menu, click OK.

m Ifyouseta Web Control Password in the Network menu,
enter it in the Password box, then click OK.

You see a screen displaying the settings you can change.

Select one of the menu options, then change any settings as
needed. These settings correspond to those found in the
projector’s menu system. See page 54 for details.

You cannot change the User’s Logo, High Altitude Mode, and
Language settings in the Extended menu or select the Reset All and
Reset Lamp Hours in the Reset menu.

Use the controls at the bottom of the screen to choose a source, stop

the action, turn off the picture and sound, or turn the projector’s

power on or off.

Monitoring the Projector Over a Network
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Lechnical Specifications

General
Type of display

Lens

Resolution
Color reproduction

Brightness (ANSI)

Contrast ratio
Image size
Projection distance
Projection methods
Focus adjustment

Zoom adjustment

Internal sound system

Optical aspect ratio

Zoom ratio

Poly-silicon TFT active matrix

F=1.8
Focal length: 6.48 mm

1280 x 800 pixels (WXGA)
Full color, 16.77 million colors

1800 lumens (High brightness mode)
1420 lumens (Low brightness mode)

500:1

44 to 110 inches (1.1 to 2.8 m)
21 to 48 inches (0.53 to 1.22 m)
Front, rear, ceiling

Manual

Digital

10 W monaural

16:10 (horizontal:vertical)

1:1.35
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note

Lamp life results will vary
depending upon mode
selected, environmental
conditions and usage. Lamp
brightness decreases over
time.
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Noise level

Keystone correction
angle

Projection Lamp

Power consumption

Lamp life

Remote Control

Range

Batteries (2)

Dimensions
Height

Width

Depth

Weight

Electrical
Rated frequency

Power supply

Power consumption

35 dB (High brightness mode)
28 dB (Low brightness mode)

+ 15° vertical (maximum)

170 W UHE

About 3000 hours (High brightness);
4000 hours (Low brightness)

20 feet (6 m)
Alkaline AA

6.2 inches (157 mm)
12.9 inches (327 mm)
10.7 inches (272 mm)
7.91b (3.6 kg)

50/60 Hz

100 to 120 VAC, 2.8 A
200 to 240 VAC, 1.2 A

Operating: 251 W
Standby: 4.2 W (network off)
4.9 W (network on)



Environmental

Temperature

Humidity

Altitude

Operating: 41 to 95 °F (5 to 35 °C)
Storage: 14 to 140 °F (10 to 60 °C)

Operating: 20 to 80% RH,
non-condensing

Storage: 10 to 90% RH,
non-condensing

Up to 4,900 feet (1,500 m)
Up to 7,500 feet (2,286 m) with High
Altitude Mode enabled; see page 62

Safety and Approvals

United States

Canada

pixelworks”

FCC Part15B Class B (DoC)
UL60950-1

ICES-003 Class B
CSA C22.2 No. 60950-1

Pixelworks™ DNX™ ICs are used in this
projector.

Technical Specifications
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Compatible Video Formats

You can use any of the following video sources: VCR, DVD player,
camcorder, digital camera, or gaming console. The projector supports
composite video, S-Video, component video, and RGB video, and it
automatically senses the video format (HDTV, SDTV, NTSC, PAL,
or SECAM).

The projector supports these international video standards:

Mode Refresh Rate (Hz)
NTSC 60
NTSC 4:3 60
PAL 50
M-PAL 60
N-PAL 50
PALBO 60
SECAM 50
TV525i 60
TV625i 50
SDTV (480p and 480i) 60
SDTV (5676p and 576i) 50
HDTV720p 60
HDTV720p 50
HDTV1080i 60
HDTV1080i 50




Compatible Computer Display Formats

You can connect the projector to a wide range of computers, including
PCs and notebooks, Apple Macintosh, PowerPC and Intel Core
Macintosh computers, PowerBook computers, many iMac and iBook

series systems, and high-end workstations such as the Sun®
SPARCstation.™

Although images are displayed at the projector’s native resolution of
1280 x 800 pixels, Epson’s patented SizeWise chip supports computer
display formats ranging from VGA through WSXGA+.

To project images output from a computer, the computer’s external
monitor signal must be set at a refresh rate (vertical frequency) that’s
compatible with the projector; see the following table for compatible
formats. For best results, the computer’s resolution should be set to
match the projector’s native resolution (1280 x 800). If this resolution
isn’t available, select one of the other compatible formats:

B Windows:
Right-click the desktop, select Properties, click the Settings tab,
and select a compatible resolution. (For a notebook displaying
through an external monitor port, you’ll need to click the
Advanced button on the Settings tab, then adjust the resolution
of the external monitor.)

m  Macintosh OS X:
From the Apple menu, select System Preferences, then click
Displays. Make sure the VGA Display or Color LCD dialog box
is selected, then click the Display tab and select a compatible
resolution.

You may need to modify existing presentation files if you created them

for a different resolution. See your software documentation for details.

Technical Specifications
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The projector supports these monitor display formats:

Refresh rate

Mode (Hz) Resolution
VGA—60 60 640 x 480 (640 x 360%)
VESA—72 72 640 x 480 (640 x 360%)
VESA—75 75 640 x 480 (640 x 360%)
VESA—S85 85 640 x 480 (640 x 360%)
SVGA—56 56 800 x 600 (800 x 450%)
SVGA—60 60 800 x 600 (800 x 450%)
SVGA—72 72 800 x 600 (800 x 450%)
SVGA—T75 75 800 x 600 (800 x 450%)
SVGA—85 85 800 x 600 (800 x 450%)
XGA—60 60 1024 x 768 (1024 x 576*)
XGA—70 70 1024 x 768 (1024 x 576*)
XGA—75 75 1024 x 768 (1024 x 576*)
XGA—85 85 1024 x 768 (1024 x 576*)
WXGABO-1 60 1280 x 768
WXGABO-2 60 1360 x 768
WXGA 60 1280 x 800

75 1280 x 800

85 1280 x 800
WXGA+ 60 1440 x 900

75 1440 x 900

85 1440 x 900
WSXGA+60** 60 1680 x 1050
SXGAB0 60 1280 x 960

1280 x 1024

iIMAC VGA 117 640 x 480 (640 x 360%)
iIMAC SVGA 95 800 x 600 (800 x 450%)
iIMAC XGA 75 1024 x 768 (1024 x 576*)
MAC13 67 640 x 480
MAC16 75 832 x 624
MAC19 75 1024 x 768

*  Letterbox signal

** Available only when Resolution is set to Wide in the Signal menu.




Notices

This chapter includes safety instructions and other important information
about your PowerLite projector.

Important Safety Instructions

Follow these safety instructions when setting up and using the projector:

B Do not place the projector on an unstable cart, stand, or table.
B Do not use the projector near water or sources of heat.

B Use the type of power source indicated on the projector. If you are not
sure of the power available, consult your dealer or power company.

B Dlace the projector near a wall outlet where the plug can be easily
unplugged.

B Insert the projector’s two-prong plug into a properly grounded outlet.
Do not hold the plug with wet hands.

B Take the following precautions for the plug. Failure to comply with
these precautions could result in sparks or fire: Do not insert the plug
into an outlet with dust present. Insert the plug firmly into the outlet.

B Do not overload wall outlets, extension cords, or integral convenience
receptacles. This can cause fire or electric shock.

B Do not place the projector where the cord can be walked on. This may
result in fraying or damage to the plug.

B Unplug the projector from the wall outlet before cleaning. Use a damp
cloth for cleaning. Do not use liquid or aerosol cleaners.

B Do not block the slots and openings in the projector case. They provide
ventilation and prevent the projector from overheating. Do not operate
the projector on a sofa, rug, or other soft surface, or in a closed-in
cabinet unless proper ventilation is provided.

B Never push objects of any kind through the cabinet slots. Never spill
liquid of any kind into the projector.
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B Except as specifically explained in this User’s Guide, do not attempt to
service this product yourself. Refer all servicing to qualified personnel.
Opening or removing covers may expose you to dangerous voltages and
other hazards.

B Unplug the projector from the wall outlet and refer servicing to qualified
service personnel under the following conditions: When the power cord
or plug is damaged or frayed. If liquid has been spilled into the
projector, or if it has been exposed to rain or water. If it does not operate
normally when you follow the operating instructions, or if it exhibits a
distinct change in performance, indicating a need for service. If it has
been dropped or the housing has been damaged.

| The lamp(s) in this product contain mercury. Please consult your
state and local regulations regarding disposal or recycling. Do not put
in the trash.

B Unplug the projector during lightning storms or when it will not be used
for extended periods.

B Do not place the projector and/or remote control on top of
heat-producing equipment or in a hot location.

B If you use the projector in a country other than where you purchased it,
use the correct power cord for that country.

B Do not stand on the projector or place heavy objects on it.

B Do not use the projector outside of the required temperature range of
41 t0 95 °F (5 to 35 °C). Doing so may cause an unstable display and
could lead to projector damage.

B Do not store the projector outside of the required temperature range of
14 to 140 °F (-10 to 60 °C) or in direct sunlight for long periods of
time. Doing so may cause damage to the case.

WARNING: The cords included with this product contain chemicals,
including lead, known to the State of California to cause birth defects or
other reproductive harm. Wash hands after handling. (provided in accordance
with Proposition 65 in Cal. Health & Safety Code § 25249.5 et seq).



FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a
Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against harmful interference in a
residential installation. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio or television reception.
However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause interference to radio and television
reception, which can be determined by turning the equipment off and on,
the user is encouraged to try to correct the interference by one or more of the
following measures:

B Reorient or relocate the receiving antenna.
B Increase the separation between the equipment and receiver.

B Connect the equipment into an outlet on a circuit different from that to
which the receiver is connected.

B Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this
equipment will invalidate the FCC Certification or Declaration of this device
and may cause interference levels which exceed the limits established by the
FCC for this equipment. It is the responsibility of the user to obtain and use
a shielded equipment interface cable with this device. If this equipment has
more than one interface connector, do not leave cables connected to unused
interfaces. Changes or modifications not expressly approved by the
manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

This Class B digital apparatus meets all requirements of the Canadian
Interference-Causing Equipment Regulations.

Cer appareil numérique de la classe B respecte routes les exigences du Reglement
sur le materiel brouilleur du Canada.

Notices
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Index

A/V cable, 26 to 27
A/V Mute, 48, 63, 67 to 68, 84, 89
Accessories, 13, 92
Adapter, Macintosh, 21
Air filter
cleaning and replacing, 74 to 76
purchasing, 13
Altitude, 63, 107
AMX Device Discovery setting, 97
Anti-theft device, 13
Aspect ratio, 50, 60, 105
Aspect setting, 60
Audio
adjusting volume, 43, 61
cable, 24, 89
connecting laptop, 24
problems, troubleshooting, 89
turning off, 48
Auto button, 43, 59
Auto Setup setting, 43, 59

Background Color setting, 63, 69
Banding in image, 88

Batteries, replacing, 51
Blackboard color mode, 47, 57
Blank screen, 38 to 39, 84 to 85
Blue background, 63

Blurry image, 87

Brightness, 76, 105

Brightness Control setting, 42, 84
Brightness setting, 42, 57, 84, 88

Browser, monitoring projector with, 103

Bucttons, disabling projector, 61, 71

Cables, 10 to 13, 92
Camcorder, connecting to, 26 to 33
Carrying case, optional, 80
Ceiling
mount, 13, 19
projection, 19, 63
Cleaning
air filter and vents, 74 to 76
lens, 74
projector case, 74
Closed Caption setting, 62
Color
adjusting, 47, 56 to 58
problems, 88
specifications, 105
Color Adjustment setting, 58
Color Mode, 47, 57
Color Saturation setting, 57
Component-to-VGA video cable, 12 to 13, 26,
30
Composite video cable, 26 to 27
Computer
cable, 10, 20 to 22
connecting to projector, 20 to 24
source, selecting, 21, 22, 38, 46, 59
support, 7
supported display formats, 109 to 110
Computer/Component Video ports, 21 to 22,
29, 46
Connecting projector
to a computer, 20 to 24
to a game console, 26 to 33
to a video source, 26 to 33
to external monitor, 23
to speakers, 25, 33
Contrast, 105
Contrast setting, 57, 88
Control Panel Lock setting, 61, 71
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Default password, 66

Default settings, restoring, 72

Digital camera, connecting to, 26 to 33
Dimensions, 106

Direct Power On setting, 63

Distance from projector to screen, 16, 105
Documentation, using, 9

DVD player, connecting to, 26 to 33

E-mail alerts, 97 to 98, 102
EMP Monitor

monitoring the projector, 98 to 102

problems, 91

using, 98 to 102
Entering the password, 70
Environmental specifications, 107
Epson

accessories, 13, 92

Extra Care Road Service, 10

PrivateLine Support, 9, 92

Store, 92

technical support, 9, 91 to 92
Ethernet connection, 95
Extended menu, 54, 62 to 63
External monitor, connecting, 23
Extra Care Road Service, 10
E-Zoom button, 49

FCC compliance statement, 113
Filter, cleaning and replacing, 74 to 76
Focusing, 40

Foot release lever, 41

Freeze button, 48

Front projection, 16 to 18, 63
Front/Ceiling setting, 19, 63

Full Lock setting, 61, 71
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Game color mode, 47, 57

Game console, connecting to, 26 to 33

Height of image, adjusting, 41

Help, 9, 91 to0 92

Help system, using, 82

High Altitude Mode setting, 63, 107
High brightness, 42, 76, 84, 105

iBook, connecting to, 20 to 21
iMac, connecting to, 12, 20 to 22
Image
capturing and saving in projector, 67 to 68
correcting shape of, 42, 60, 86
fitting on screen, 43, 59, 60, 86
focusing, 40
freezing, 48
height, adjusting, 41
menu, 54, 56 to 58
positioning, 41, 43, 59
problems, 84 to 88
raising, 41
selecting source, 21, 22, 27, 37, 38, 46,
59 to 60
shape, correcting, 42, 60, 86
size and projection distance, 16, 105
turning off, 48
zooming, 49
Info menu, 54, 64 to 65
Input signal, selecting, 21, 22, 27 to 30, 38,
46, 59 to 60
Installing software, 94
Instant Off feature, 44

Kensington anti-theft device, 13
Keystone correction, 42, 60, 86, 106



Lamp
automatic shutoff, 44
brightness, 76, 84, 105
number of hours used, 64, 76, 79, 106
replacing, 76 to 79
specifications, 106
status light, 82 to 83
timer, resetting, 79
Language setting, 63
Laptop computer
connecting to, 20 to 22
displaying on, 38 to 39, 85
LCD panels, 7
Lens
cleaning, 74
specifications, 105
Lights, status, 82 to 83
Logo
creating, 67 to 68
displaying, 68 to 69
turning on, 63, 69
Low brightness, 42, 76, 105

Macintosh
adapter, 21
connecting, 20 to 22
Manuals, 9
Menus
changing settings, 55 to 56
Extended, 54, 62 to 63
Image, 54, 56 to 58
Info, 54, 64 to 65
Network, 54, 64, 96 to 98
Reset, 54, 72
Settings, 54, 60 to 61
Signal, 54, 58 to 60
User’s Logo, 67 to 68
using, 54 to 56
Messages setting, 62
Monitor, external, 23

Monitoring projector
e-mail notifications, 97 to 98, 102
EMP Monitor, 98 to 102
with browser, 103

Moving projector, 80

Network
connecting to, 95
managing projector remotely, 93 to 103
menu, 54, 64, 96 to 98
problems, 91
settings, 64, 96 to 98, 99
system requirements, 94
Network Protect password, 69
Noise level, 106

Options for projector, 13, 92

Password
default, 66
entering, 70
logo protection, 67 to 70
Network Protect, 69
problems, 89
prompt, 37, 70
request code, 70
setting, 68 to 69
turning on, 69
Photo color mode, 47, 57
Picture source, selecting, 21, 22, 27 to 30, 38,
59 to 60
Pixelworks, 107
Position setting, 59
Positioning
image, 41, 59
projector, 16 to 19

Index
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Power

button, 37, 44

consumption, 106 Raising image, 41
light, 36, 82 to 83 RCA A/V cable, 26 to 27
supply, 106 Rear projection, 19, 63
PowerBook, connecting to, 20 to 22 Registration, 10
Presentation color mode, 47, 57 Remote control
Presenters Online, 9 problems, 90
PrivateLine Support, 9, 92 receivers, disabling, 61, 84, 90
Problems replacing, 13, 92
color, 88 replacing batteries, 51
image, 84 to 88 specifications, 106
monitoring projector, 91 using, 45 to 51
network, 91 Remote Receiver setting, 61, 84, 90
password, 89 Replacing
remote control, 90 air filter, 74 to 76
sound, 89 lamp, 76 to 79
Projection lamp, see Lamp remote control, 13, 92
Projector remote control batteries, 51
accessories, 13, 92 Request code, password, 70
carrying case, optional, 80 Reset menu, 54, 72
cleaning, 73 to 76 Resolution, 7, 65, 105, 109 to 110

disabling buttons, 61, 71
distance from screen, 16, 105
foot, adjusting height with, 41
lamp specifications, 106
monitoring remotely, 93 to 103
password protection, 66 to 70

positioning, 18 to 19 ; X
resolution, 7, 105, 109 to 110 Screen, distance from projector, 16, 105

Screens, portable, 13

Setting a password, 68 to 69

Settings menu, 54, 60 to 61

Sharpness setting, 58

Signal menu, 54, 58 to 60

Sleep mode, 44, 63

Software installation, 94

Sound, see Audio

Quick Setup sheet, 9 Source Search button, 21 to 22, 27 to 30,
37 to 38, 46

Speaker, specifications, 105

Speakers, connecting external, 25, 33

Specifications, technical, 105 to 110

Sports color mode, 47

sRGB color mode, 47, 57

Safety
approvals, 107
instructions, 111 to 112
Screen logo, see User’s Logo

transporting, 80

turning off, 44

turning on, 36 to 37

unpacking, 10

viewing information about, 64 to 65

118  Index



Standby Mode setting, 63, 99
Startup screen

creating, 67 to 68

displaying, 68 to 69

user’s logo, see User’s Logo
Startup Screen setting, 63
Status lights, 82 to 83
Stopping action, 48
Stripes in image, 88
Support, 9, 91 to 92
S-Video cable, 12, 13, 26
Switching picture source, 38, 46
Sync, adjusting, 59, 87 to 88
System requirements, network, 94

Technical support, 9, 91 to 92
Temperature
light, 82 to 83
requirements, 107
Test Pattern setting, 61
Text color mode, 47
Theatre color mode, 47, 57
Timer, lamp, 79
Tint setting, 58
Tracking, adjusting, 59, 87 to 88
Transporting projector, 80
Troubleshooting
color, 88
cut-off image, 43, 86
image quality, 87 to 88
image shape, 86
network problems, 91
no image, 84 to 85
no sound, 89
password, 89
remote control problems, 90
Turning off
audio, 48
picture, 48
projector, 44

Turning on
password, 69
projector, 36 to 37
User’s Logo, 63, 69
Typing the password, 70

Unpacking projector, 10
User’s Logo
creating, 67 to 68
displaying, 68 to 69
turning on, 63, 69

VCR, connecting to, 26

VGA computer cables, 10, 20 to 22

Video
display settings, 64 to 65
formats, supported, 7, 108
source, connecting to, 26 to 33

source, selecting, 27, 37 to 38, 46, 59 to 60

Video Signal setting, 60
Volume, adjusting, 43, 61

Warning lights, 82 to 83
Warranty, 10
Weight, 106

Zoom ratio, 105
Zoom setting, 60
Zooming image, 49

Index 119



EPSON

EXCEED YOUR VISION



	Front Matter
	Important Safety Information
	Copyright Notice
	Trademarks

	Contents
	Welcome
	Getting the Most from Your Projector
	Using Your Documentation
	Getting More Information

	Registration and Warranty
	Unpacking the Projector
	Projector Parts
	Additional Components
	Optional Accessories

	Setting Up the Projector
	Positioning the Projector
	Whiteboard Installation
	Other Installations

	Connecting to a Computer
	Connecting with the VGA Cable
	Connecting with a VGA-5BNC Cable
	Connecting an External Monitor
	Playing Sound Through the Projector
	Connecting External Speakers

	Connecting to Video Sources
	Connecting a Composite Video Source
	Connecting an S-Video Source
	Connecting an RGB Video Source
	Connecting a Component Video Source
	Playing Sound Through the Projector


	Projecting
	Turning On Your Equipment
	Turning On the Projector
	Selecting the Image Source
	What To Do If You See a Blank Screen

	Adjusting the Image
	Focusing and Zooming Your Image
	Adjusting the Height of Your Image
	Adjusting the Image Shape
	Adjusting the Brightness
	Correcting Computer Images

	Adjusting the Volume
	Shutting Down the Projector

	Using the Remote Control
	Controlling the Picture and Sound
	Switching Between Picture Sources
	Adjusting the Color Mode
	Turning Off the Picture and Sound
	Stopping Action
	Zooming Your Image
	Changing the Image’s Aspect Ratio

	Replacing the Batteries

	Fine-tuning the Projector
	Using the Projector’s Menu System
	Changing Menu Settings

	Adjusting Colors and Clarity
	Adjusting the Input Signal
	Customizing Projector Features
	Selecting Projector Setup Options
	Selecting Network Settings
	Viewing Lamp Usage and Other Information
	Using the Projector’s Security Features
	Creating Your Own Screen Logo
	Setting a Password
	Turning On the Password and User’s Logo
	Starting the Projector with a Password
	Disabling the Projector’s Buttons
	Installing Security Locks

	Restoring the Default Settings

	Maintenance and Transportation
	Cleaning the Lens
	Cleaning the Projector Case
	Cleaning and Replacing the Air Filter
	Replacing the Lamp
	Resetting the Lamp Timer
	Transporting the Projector

	Solving Problems
	Using On-Screen Help
	What To Do When the Lights Flash
	Solving Problems with the Image or Sound
	Solving Password Problems
	Solving Problems with the Remote Control
	Solving Network Problems
	Where To Get Help
	Speak to a Support Representative


	Monitoring the Projector Over a Network
	Installing the Network Software
	Windows System Requirements
	Installing the Software on a Windows System

	Connecting to the Network
	Selecting Network Settings
	Using Projector E-mail Alerts

	Using EMP Monitor
	Opening and Closing EMP Monitor
	Registering a Projector
	Monitoring Your Projector
	Using E-mail Alerts

	Using a Browser to Monitor the Projector

	Technical Specifications
	General
	Projection Lamp
	Remote Control
	Dimensions
	Electrical
	Environmental
	Safety and Approvals
	Compatible Video Formats
	Compatible Computer Display Formats

	Notices
	Important Safety Instructions
	FCC Compliance Statement

	Index

